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 ایجاد اسلاید و پرزنتیشن 
 چیست؟  (Slide) اسلاید
های مشابه ساخته  یا برنامه (PowerPoint) ی نمایشی است که در پاورپوینتاسلاید یک صفحه •

 .شودمی
بگذاریم تا موضوعی را بهتر  و اشکال را  ویدیو    ،توانیم متن، عکس، جدول، صدادر هر اسلاید می •

 .توضیح بدهیم
شوند، در پاورپوینت هم اسلایدها  یکی عوض میها یکیطور که در کتاب، صفحهیعنی همان •

 .شوندیکی نشان داده مییکی
 .ی سیارات درس بدهدخواهد در کلاس دربارهفرض کنید معلم می

 .شود و فهمیدن سخت استمی خیلی پراگندهی معلومات را در یک صفحه بنویسد،  اگر همه
 :پس بهتر است

 یک اسلاید برای معرفی خورشید،  •
 یک اسلاید برای زمین،  •
 … یک اسلاید برای مریخ و •

 فهمد. تر میآموز راحتطوری هر صفحه )اسلاید( فقط یک موضوع کوچک دارد و دانش این
 

 برای فهم بهتر یک مثال ساده را مرور میکنیم:
 :فکر کنید کتاب قصه دارید        
 ی اول = روی جلد کتاب )عنوان قصه(صفحه •
 ی دوم = معرفی قهرمان قصه صفحه •
 ی سوم = شروع ماجرا صفحه •

 :در پاورپوینت هم همین است
 "عنوان "سیارات منظومه شمسی →اسلاید اول  ▪
 ی زمینیک عکس زمین + چند خط درباره →اسلاید دوم  ▪
 ی مریخ یک عکس مریخ + چند خط درباره →اسلاید سوم  ▪

برای ایجاد کردن   شود.ی کتاب است که به ترتیب نمایش داده مییعنی هر اسلاید مثل یک صفحه
 افزار آفلاین و آنلاین استفاده کنیم. اسلایدها میتوانیم از دو نرم

 "  Ms. PowerPoint  "، مایکروسافتGoogle Slideآنلاین شرکت " گوگل " .1
 ( Office Collectionمجموعه برنامه های آفیس ) .2
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 افزارهای است که در این بخش استفاده میشود.این دو نمونه از بهترین نرم

 
 افزارها و خدمات آنلاین دسترسی به نرم 

 افزارهای گوگل نرم  .1
   Google Docs ،Google Drive : مانند) افزارهای گوگلبرای نصب و استفاده از نرم •

 .کافی است  Gmail حسابداشتن یک  ... و
 افزارهای مایکروسافت نرم  .2

نیز باید یک   Word یا "PowerPoint"افزارهای مایکروسافت مانند برای استفاده از نرم  •
 .بسازید Microsoft Live حساب

 .توانید به خدمات آنلاین مایکروسافت دسترسی داشته باشیدبا این حساب می •
 ( آفلاین)  مایکروسافت  افزارهاینرم  .2

  روی  یکجا را( Microsoft Office) مایکروسافت  اداری محصولات تمام توانیدمی شما •
 . کنید نصب کمپیوتر

  و Word، Excel :مانند افزارهانرم از توانیدمی نیز اینترنت  به نیاز بدون حالت  این در •
PowerPoint پردازیم، توجه ما به نسخه آفلاین  که فعلاً به نسخه نمی .کنید  استفاده

 میباشد. 
برای آفلاین شما نیاز دارید سافت این بسته خریداری کند که در افغانستان معمولاً شما میتوانید از  

 خدمات سافت ویری این بسته را تهیه کنید. 

 در ویندوز  PowerPoint افزارمراحل باز کردن نرم 
 .)شروع( در پایین صفحه کلیک کنید  Start Menuی  روی دکمه .1
 .را تایپ کنید  PowerPointی در قسمت جستجو، کلمه .2
 .شودظاهر می  PowerPointدر لیست پیشنهادی، آیکن  .3

  گوگل اسلاید
  "آنلاین"

 مایکروسافت پاورپوینت
 )آفلاین، آنلاین(
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 .کلیک کنید کلیک چپ موسبا  PowerPoint روی آیکن .4
 .توانید اسلاید جدید بسازیدشود و میبرنامه برای شما باز می .5

 
 روش ساده: 

ابتددددددددداو از کیبددددددددورد همزمددددددددان کلیدددددددددهای 
فشددددددار میدهیدددددددد در  Window+Rترکیبددددددی 

 powerpntپنجددددره بدددداز شددددده ایددددن کلمدددده را 
را از کیبدددددورد فشدددددار  Enterبنویسدددددید بعدددددد 

بدهددددددد. میبنددددددی کدددددده برنامدددددده پاورپوینددددددت 
 برایتان باز میشود.

 
 

 ایجاد اسلاید: 
کنید، در  را باز می   PowerPointوقتی شما  

صفحه یک  داده ابتدا  نمایش  خالی  ی 
را     (Blank Presentations)  از مینوی فایل شما یک  .این صفحه هیچ متن یا محتوایی ندارد.شودمی

( آماده برای اسلایدهای استفاده کنید.  Templateحتی شما میتوانید از ساختارهای )   . انتخاب میکنید
یک   باید  شما  شروع،  با  برای  اسلاید 

 .ایجاد کنید ساختار دلخواه خودتان
توانید موارد مختلف اضافه  در اسلاید می

 :کنید، مانند
 متن         •
 تصویر             •
 ویدیو        •
 (Shapes) اشکال    •
 ها و نمودارها گراف       •
 صداها   •
 ها آیکن     •
شود ترکیب این عناصر باعث می 

 .تر شوداسلاید شما زیباتر و آموزشی
  مختلف  های بخش  از   اسلاید  که  بدانید  باید  سازید،می  جدید   اسلاید  یک  پاورپوینت   در  شما   وقتی

 . است دیگر چیزهای یا عکس  متن، گذاشتن برای  جایی بخش  هر. شودمی ساخته
 

 11دوز افزار پاورپوینت در ویننحوه باز کردن نرم

 انتخاب ساختاراسلایدهای مینو



 
4 

 

 های اصلی یک اسلاید بخش 

 (Title) عنوان .1
 .گیردمعمولاً در بالای اسلاید قرار می •
 .این قسمت برای نوشتن نام موضوع یا عنوان درس است •

 (Content / Text Box) متن اصلی .2
 .شوددر وسط اسلاید دیده می •
 .توانید متن توضیحی، جملات یا نکات مهم را بنویسیداینجا می •

 (Picture/Video Placeholder) جای عکس یا ویدیو .3
 .تر شودتوانید عکس یا ویدیو اضافه کنید تا درس جالبمی •

 (Shapes & Icons) ها اشکال و آیکن .4
 .شودبرای نشان دادن مفاهیم به صورت تصویری استفاده می •

 (Chart / Graph) نمودار و گراف  .5
 .برای نمایش اطلاعات عددی یا آماری به شکل ساده و قابل فهم •

 (Notes Section) یادداشت معلم .6
 .شود(در پایین صفحه )فقط برای خودتان دیده می •
 .توانید نکات مهم یا توضیحات اضافی را اینجا بنویسیدمی •

 
 

می شما  که  از  تصویر  یکی  بیند 
که  ساده است  اسلایدهای  ترین 

دارایی یک عنوان و دو عنوان فرعی  
میباشد که معمولاً در پرزنتشین ها  
استفاده   اول  اسلایدهای  در 

 میشود.
 
 
 

 Slide) انتخاب طرح آماده
Layout)  

 :دارد، مثل های آمادهطرحپاورپوینت برای راحتی شما 

 PowerPointاولین اسلاید 
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 فقط عنوان •
 عنوان + متن •
 عنوان + عکس  •
 دو متن کنار هم •
 نمودار یا جدول  •

 .توانید اسلاید مناسب درست کنیدتر میشما سریع Layout با انتخاب هر

 چطور یک اسلاید جدید در پاورپوینت بسازیم؟ 

 :وقتی پاورپوینت باز باشد

 .بروید (Ribbon) به نوار بالا .1
 .کلیک کنید  Homeبه نام  (Tab) روی تب .2
 .)اسلاید جدید( را فشار دهید  New Slideی  دکمه   Slidesدر بخش  .3

o  شودمی اضافه خالی  اسلاید یک →اگر همان دکمه را مستقیم بزنید. 
o   های آمادهطرح  لیست  →اگر روی فلش کوچک کنار آن کلیک کنید (Layout)   نمایش

 .شود )مثلاً: فقط عنوان، عنوان + متن، عنوان + تصویر و غیره(داده می

 (Shortcut) ترروش سریع

 :روی کیبورد کلیدهای زیر را فشار دهید
• Ctrl + M → شودیک اسلاید جدید ساخته می. 
 :ترین راه این است که پس برای آماده کردن یک اسلاید جدید، ساده     

Home → New Slide   یاCtrl + M 
 

 

 
 

Slide  اسلاید 
 .اسلاید جدید بسازید  New Slideبا  •
 .انتخاب کنید: عنوان، متن، عکس یا خالی (Layout) ساختار •

اضافه کردن اسلایدها  
آن بیشتر و تغیرات ساختار  



 
6 

 .توانید متن، تصویر، ویدیو، شکل، آیکن و نمودار اضافه کنیدمی •
 .شود وارد کردصدا یا موسیقی هم می •

Table  جدول 

 .جدول بسازید  Insert > Tableاز  •
 .تعداد سطر و ستون را انتخاب کنید •
 .ها و تغییر اندازه استفاده کنیدبرای رنگ، خط دور، ادغام خانه Layout و Designاز  •

Picture   تصویر 
 .عکس از کامپیوتر یا اینترنت اضافه کنید Insert > Picturesاز  •

 
 
 
 
 
 
 

Shapes  اشکال 
 .توانید مربع، دایره، فلش و… رسم کنیدمی Insert > Shapes در  •

 Icons ها آیکن 
 .نمادهای آماده مثل کتاب، تلفن یا لامپ اضافه کنید Insert > Icons در  •

SmartArt 
 .شودهای سازمانی استفاده میبرای نمایش نمودارهای آماده و شکل •

 Chart نمودار 
 .ای، خطی و غیره استفاده کنیدبرای نمودار ستونی، دایره  Insert > Chart از  •

 
 
 
 

 بخش اسلاید جدید، جدول و تصویر
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 3D Models 
مدل • کردن  سهاضافه  بعدی های 

 .برای جذابیت بیشتر
 

Links   هالینک 
•  Zoom → رفتن سریع به بخشی از اسلایدها. 
•  Link → )گذاشتن لینک )مثلاً به سایت یا یک اسلاید دیگر. 
•  Action → )تعیین کار برای کلیک موس )مثل رفتن به اسلاید بعدی یا پخش صدا. 

Text متن 

•  Text Box → برای نوشتن متن آزاد در هر جای اسلاید. 
•  Header & Footer → )نوشتن عنوان پایین یا بالای هر اسلاید )مثلاً شماره صفحه. 
•  WordArt → های هنری و زیبا متن. 
•  Date & Time →  اضافه کردن تاریخ و وقت. 
•  Slide Number → گذاری اسلایدهاشماره. 
•  Object → های دیگر  وارد کردن فایل

 .)مثل اکسل یا ورد(

 

Video  ویدیو 

 .توانید فیلم از کامپیوتر یا آنلاین وارد کنیدمی Insert > Video از   •

 Audio صدا 
 .موسیقی یا صدای خودتان را قرار دهید  Insert > Audioاز  •

 

 ها ترانزیشن Transitions تب 

 .جایی بین اسلایدهاجابهمخصوص  •
توانید هنگام رفتن از یک اسلاید به  می •

های زیبا )مثل محو  اسلاید بعدی، افکت
 .شدن، سر خوردن یا چرخیدن( بگذارید

 ، لینکهاتصاویر سه بعدی، اشکال،نمودار، آیکن

 بخش متونها همراه با تمام اساتیل

 بخش ویدیو، اسکرین ریکارت، صدا
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 :های مهمگزینه •
o  Transition to This Slide →  انتخاب افکت. 
o  Effect Options →  تغییر حالت افکت. 
o  Timing → تنظیم سرعت و صدا. 

 :کلید میانبر  
 F5 :ترانزیشن میانبر خاص ندارد، اما برای اجرای اسلاید •

 

 هاانیمیشن(Animations) تب 
 .ها در داخل یک اسلایدحرکت دادن متن، عکس، جدول و شکلمخصوص  •
 :هاانواع انیمیشن  •

o  Entrance(ظاهر شدن( 
o Emphasis  (تاکید/تکان خوردن ) 
o Exit  (ناپدید شدن) 
o Motion Paths (حرکت در مسیر مشخص) 

•  Animation Pane →  هاکنترل ترتیب انیمیشن. 
 
 :کلید میانبر  
•  Alt + A → باز کردن تب “Animations” . 
•  Alt + Shift + F9 → باز کردن “Animation Pane” . 

 

 نمایش اسلاید Slide Show تب 
 .اجرای نهایی اسلایدهابرای  •
 :های مهمگزینه •

o  From Beginning (F5) → نمایش از اول. 
o  From Current Slide (Shift + F5) → نمایش از همین اسلاید. 
o  Rehearse Timings → بندیتمرین زمان. 
o  Set Up Slide Show → ایتنظیمات حرفه. 

 :کلیدهای میانبر مهم  
•  F5 → شروع نمایش از اول. 
•  Shift + F5 →  شروع از اسلاید فعلی. 
• Esc → خروج از نمایش. 
• → (Right Arrow) یا Space → رفتن به اسلاید بعدی. 
• ← (Left Arrow)  یا Backspace → برگشت به اسلاید قبلی. 
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 ذخیره کردن اسلایدها در پاورپوینت      

 .در بالا کلیک کنید File روی  .1
 .را انتخاب کنید Save As یا  Save گزینه   .2
 .برای فایل بنویسید  نامیک  .3
 .را انتخاب کنید ”Documents“ یا ”Desktop“ مثل سازیمحل ذخیره .4
 .کلیک کنید Save روی  .5

 نکته مهم     

 .شودذخیره می ( (pptx.فایل اسلایدها با پسوند  •
 :ذخیره کنید  PDF اگر خواستید به شکل عکس یا  •

 File → Save As → مثلا:   انتخاب نوع فایل (PDF, JPEG, PNG) 

 (ویدیوبرای درک بهتر میتواند مجموعه ویدیوهای آموزشی این دوره را ببنیده باشید. )
 فعالیت ها: 

ای باز کردن اپلیکشن پاورپوینت را بصورت دانش آموزان مطالعه و دیدن بعضی ویدیوها نحوه .1
 آفلاین تمرین کند. 

بعد از بازکردن یک اسلاید خالی ایجاد کرده و در عنوان اصلی و دو عنوان فرعی برای آن ایجاد   .2
 نماید.

 بخش انیمشن در پاورپوینت

https://youtube.com/playlist?list=PL0C-3ajBGn8yMQ8J3y0N7FTOtvYNB4lTM&si=l-Mx8LsK08xT_ztO
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انیمشن به هر   Tabدانش آموزان در یک اسلاید تصویر و متن را با هم ترکیب کنند و بعد از  .3
 کدام آنها انیمشن بدهد.

 در یک اسلاید اشکال و نمودارها را ترکیب کنند و جزئیات منظم را تمرین کند.  .4
دانش آموز به متن انمیشن همراه باصدا که از کمپیوتر خود دانلود کرده است را با متن ترکیب   .5

 کنند.
بعد از تهیه یک اسلاید با تمام جزئیات دانش آموز نحوه ذخیره سازی با چند فرمت را تمرین   .6

 نماید.
 سوالهای چالشی:

 ما چند نوع نرم افراز ساخت پرزنتیشن ای اسلاید داریم؟ .1
مربوط کدام شرکت میشود و چگونه میتوانیم از آن استفاده کنیم به   PowerPointنرم افزار  .2

 چند روش؟ 
 نرم افزار پاورپوینت معمولاً چگونه به بازار عرضه میشود؟  .3
 ها چی چیرهای را میتوانیم ترکیب کنیم؟ در سلایدهای پاورپوینت برعلاوه متن .4
 برای ایجاد انمیشن به متون و تصاویر همراه با صوت از کدام تب ها استفاده کنیم؟ .5

 

 درس سوم 
 ارتباط و شریک ساختن معلومات:

 ساختن، ویرایش و استفاده مخاطبین
Contact  (تماس  )است،  شخص  یک  معلومات از  ایمجموعه   ً عکس    گاهی  و  ایمیل  شماره،  نام،  معمولا

  برای   فایل  یا  ایمیل  پیام،  درست  و  سریع  کندمی  کمک   ما  به  هاتماس  فهرست  داشتن.  شامل میشود
 . گروهی   یا  فردی — بفرستیم افراد

 اهداف این بخش 
 .بسازد، ویرایش کند و حذف نماید Contact شاگرد بداند چگونه •
 .هنگام ارسال پیام و ایمیل استفاده کند Contact شاگرد بداند چگونه از •
 .(group, CC, BCC  ،broadcast) شاگرد بداند چگونه به چند نفر همزمان پیام یا فایل بفرستد •
 .شاگرد بداند چگونه فایل/عکس را ضمیمه کند یا لینک شریک بسازد •

 
 . ساختن گام به گام مخاطب1
A  :( روی موبایل اندروید )مثالGoogle Contacts  ٔیا برنامهContacts) 

1. App «Contacts»  را باز کنید. 
 .را فشار دهید «Create» ی »+« یادکمه .2
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( عکس دلخواه Photoعکس ) (Email(،ایمیل آدرس )Phone(، شماره )Nameنام ) فیلدهای: .3
 است.

 .را بزنید «Save» گزینهٔ .4
 مثال ساده:

 نام کامل )احمد علی(  .1
 (0700232789شماره تماس ) .2
 ahmadali@gmail.comایمیل  .3
 ( Addگزینه اضافه یا ) .4
وقت گزینه علاوه را فشار میدهد یک باکس باز میشود از شما میپرسد آیا میخواهد این  .5

 ." انتخاب میکنیدCancelیا "  « مخاطب ثبت شود یا خیر: اگر خواستید گزینه »ذخیره
 
B )روی iPhone (Contacts / Phone app ) 

 .را باز کنید «Phone» یا «Contacts» اپ .1
 .گوشهٔ صفحه را فشار دهید «+» .2
 .«Done» نام و شماره و ایمیل را وارد کنید، سپس .3

 
C )در  Gmail (گوگل/   وب) 

 «Google apps» منوی Gmail در  یا بروید (contacts.google.com) به  و   کنید  باز   را  مرورگر .1
→Contacts   

2. «Create contact» → «Create a contact»   کنید انتخاب را. 
 «.Save» و  کنید پر را فیلدها .3

 Contact (Delete) حذف و ( Edit) ویرایش  .2
 :ویرایش

1. Contact را باز کنید. 
 .یا آیکون قلم را فشار دهید «Edit» دکمهٔ .2
 .را بزنید «Save» اطلاعات جدید را وارد و .3

 .را وارد کنید و ذخیره کنید ”Ahmad“ شمارهٔ جدید برای  :مثال
 :حذف
1.  Contact را باز کنید. 
 .را انتخاب کنید «Remove contact» یا  «Delete» گزینهٔ .2
 .خواهید حذف شودتأیید کنید که می .3

mailto:ahmadali@gmail.com
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 (Save sender from message) پیام  دریافت  هنگام  فرستنده ذخیرهٔ .3
 :کردید دریافت ناشناس  آدرس  یا شماره  از ایمیلی یا  پیام وقتی

 . کنید  باز را  ایمیل یا پیام •
 . کنید انتخاب را  Save contact یا Add to contacts  گزینهٔ •
 .کنید وارد شخص آن برای  نام یک •
 .بزنید را  Save دکمهٔ •

 
  پیدا ترراحت بعدی های پیام و کنید تایپ  دستی را آدرس نیست لازم  دیگر بعد دفعهٔ مهم؟ چرا
 .شوندمی
 (فردی) ایمیل یا  پیام ارسال  برای Contact از استفاده  .4

A)  ارسال ایمیل درGmail  )مثال( 
• Gmail  کنید  باز را → Compose. 
  پیشنهاد   را  آدرس  Gmail  →  کنید  تایپ  را  Contact  حروف  اولین  یا  نام  To  بخش  در •

 . کنید انتخاب → دهدمی
• Subject کنید  تایپ را  متن  بنویسید، را . 
 .کنید انتخاب را فایل و بزنید را« paperclip» آیکون کنید، ضمیمه خواهیدمی فایل اگر •
• Send  بفشارید را . 

B)   ارسال پیام درWhatsApp 
• WhatsApp کنید  باز را →  Chats → New chat → لیست Contacts  شودمی ظاهر. 
• Contact بنویسید را متن →  کنید لمس  را →  Send. 
 . Send → کنید  انتخاب را  عکس و بزنید را دوربین یا « attach»  آیکون: عکس ارسال برای •

C) ارسال SMS  ساده 
• Messages app کنید باز  را  →  New message   → نام  یا   شماره  Contact کنید   وارد  را 

 . Send → متن →

 ( Multiple recipients) کنندهدریافت چند به ارسال  .5

 BCC و To، CC  از  استفاده — ایمیل( الف
• To :پیام که کسانی  ً  . است شانبرای مستقیما
• CC (Carbon Copy) :کنند؛می  دریافت را پیام از کپی که کسانی  ً  . رسانیاطلاع  برای معمولا
• BCC (Blind Carbon Copy) :دیگران برای شانآدرس  اما کنندمی  دریافت کپی که کسانی 

 . شود  منتشر هاایمیل  لیست خواهیدنمی  که زمانی مناسب — ماندمی مخفی

 (:Gmail) مراحل
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1.  Compose → در To نام بار هر  یا کنید جدا کاما با را  آدرس چند Contact کنید  انتخاب را. 
 .کنید وارد  را هاآدرس  و کنید کلیک «Cc/Bcc» روی CC/BCC برای .2
 .کنید Send و اضافه را فایل و متن .3

استفاده کنید تا آدرس همهٔ افراد محفوظ   BCC برای ارسال به گروه بزرگ از ی:نکتهٔ اخلاقی/حریم خصوص
 .بماند

 (Attachments, Links, Shared Access) دیجیتال محتوای  ارسال .6
A) عکس/فایل کردن اضافه  (Attachment ) 

• Gmail: Compose → paperclip icon → Choose file → Upload → Send. 
 Google کند. فایل بزرگتر را باید باضمیمه را مستقیم قبول می MB 25تا ~  Gmail :نکته •

Drive  اشتراک کنید. 
• WhatsApp/Telegram: attach icon → Gallery/Document → Select → Send. 

B) لینک  گذاریاشتراک (Share link) 
 :خواهید دسترسی مشترک بدهیداگر فایل بزرگ است یا می •

 .آپلود کنید OneDrive یا Google Drive فایل را در .1
سطح دسترسی را انتخاب  → (Link) بسازید لینک →را بزنید  «Share» گزینهٔ .2

 .(View / Comment / Edit) کنید
 .و ارسال کنید paste لینک را در ایمیل یا پیام .3

 ( Very important)  امنیتی نکات و  خصوصی حریم حفظ .7
 . بگیرید اجازه دیگران، ایمیل یا شماره کردن  منتشر از قبل •
 .کنید  استفاده BCC از بزرگ  گروه به ایمیل ارسال برای •
 ذخیره   Contact  یک  Notes  بخش  در  را (  عبور  رمز   کارت،  شمارهٔ  مثل)  حساس   اطلاعات •

 .نکنید
 .بپرسید او از ابتدا دهید،می دوستان به را کسی   شماره اگر •
 . کنید استفاده گوشی  از  محافظت برای صفحه قفل و پسورد از •

 (Troubleshooting)  رایج   یابیاشکال .9
• Contact یا  باشد خاموش  سازیهمگام است ممکن شود؟نمی دیده  account نگاه را اشتباه  

ً ) کنیدمی  (. Google vs device کاربری  مثلا
 . کنید بررسی است؛ شده بلاک شما فرستنده یا ضعیف اینترنت شود؟نمی ارسال پیام •
 .کنید استفاده Drive لینک از — بالاست فایل حجم شود؟نمی آپلود ضمیمه فایل •
 .اندنکرده  ذخیره خود Contacts در را شما شمارهٔ  هاآن گیرند؟نمی پیام Broadcast در افراد •
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 ( Practice) شاگردان برای ساده های تمرین .10

 .کنید ایجاد ایمیل و فرضی شمارهٔ  با  Sara نام به جدید Contact یک  :۱ تمرین
 .کنید اضافه عکس یک  و کنید  ویرایش را Contact همین :۲ تمرین
   Subject: Homework — Body: Hello بنویسید Sara برای ساده ایمیل یک  :۳ تمرین

Sara, I finished the homework. —   سپس Send کنید. 
  گروهی  پیامی و  WhatsApp یا Contacts در کنید  ایجاد نفر  3 با کوچک  گروه  یک  :۴ تمرین
 .کنید ارسال
ً ) کوچک   فایل یک  :۵ تمرین   فایل  اگر کنید؛  ارسال و ضمیمه Gmail طریق از را ( عکس مثلا
 .کنید  ارسال لینک و آپلود Google Drive در را آن  است، بزرگ
ً ) :هاپاسخ   ارسال ایمیل که کند چک تواندمی معلم شاگرد؛ دستگاه  در مشاهده قابل معمولا
 .( باشد شده ارسال ضمیمه فایل  و شده  ساخته گروه شده،

 ( Video Call)  ویدیویی  تماس در  اشتراک و  آغاز .  12
1. WhatsApp  (اپواتس) 

 .کنید باز را اپواتس •
 .کنید انتخاب لیست از را نظر مورد  مخاطب •
 .کنید کلیک (Video Call) دوربین  آیکون  روی صفحه، بالای •
 .بینیدمی را او زندهٔ تصویر بدهد، جواب مقابل  طرف وقتی •
 .کنید روشن یا  خاموش را خود تصویر توانیدمی •
 .بزنید End Call روی  تماس،  ختم برای •

 

 تماس تصویر در واتسپ
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2. Zoom (زوم) 
 .کنید باز را Zoom وبسایت  یا اپلیکیشن •
 .شوید کاربری حساب وارد •
 .کنید  کلیک( جدید جلسه) New Meeting گزینهٔ روی •
ً  شما تصویر •  .شودمی فعال  فورا
 .بفرستید دوستان برای و  کنید کاپی   را جلسه لینک •
 .ببینید صفحه  در را  هاآن  توانیدمی شوند، وارد دیگران  وقتی •
 .بزنید End Meeting روی جلسه، ختم برای •

3. Microsoft Teams ( تیمز مایکروسافت ) 
 .کنید باز را Teams اپلیکیشن •
 .شوید فردی چت یا (Team) تیم وارد •
 .کنید کلیک  Video Call روی صفحه بالای •
 .کندمی دریافت نوتیفیکیشن مقابل طرف و شودمی آغاز تماس •
 .کنید صدابی را مایکروفون یا  کنید (Screen Share) اسکرین توانیدمی •
 .بزنید Leave روی  تماس پایان برای •

4. Google Meet (میت گوگل) 
 .کنید باز را Google Meet مرورگر  یا اپلیکیشن •
 .کنید کلیک  New Meeting گزینهٔ روی •
 .سازید  شریک  دیگران با را آن شود،می ساخته جلسه لینک •
  آغاز  فوری  تماس تا کنید انتخاب را Start an Instant Meeting گزینهٔ   مستقیم یا •

 .شود
  را ها آن شوند، جوین دیگران  وقتی •

 .دید خواهید صفحه در
  Leave Call روی  تماس  ختم برای •

 . بزنید
 

5. Facebook Live (لایف فیسبوک) 
 .کنید باز  را فیسبوک اپلیکیشن •
 .کنید کلیک Live Video بخش روی •
  برای خواهیدمی که کنید انتخاب •

  پخش (Public) عمومی  یا دوستان
 تماس تصویر در گوگل میت .کنید
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 .دهید فشار را Go Live دکمهٔ •
 .بگذارند کامنت  و ببینند  را شما تصویر زنده صورت  به توانندمی شما دوستان •
 . کنید کلیک End Live Video روی ختم، برای •

6. YouTube Live (لایف  یوتیوب) 
 .کنید باز  را YouTube سایت  یا اپلیکیشن •
 .بزنید (Create) + دوربین آیکون روی •
 .کنید  انتخاب را Go Live گزینهٔ •
 .کنید وارد ویدیو برای (Title) عنوان •
 .دهید فشار را Go Live دکمهٔ •
 .بدهند پیام و ببینند را شما زنده توانندمی هابیننده  •
 . کنید ختم  را پخش End Stream روی  کلیک  با •

7. Instagram (اینستاگرام Live ) 
 .کنید باز  را اینستاگرام اپلیکیشن •
 .کنید سوایپ  راست سمت  به و بروید خانه صفحهٔ به •
 .کنید انتخاب را Live گزینهٔ صفحه، پایین •
 .دهید فشار را  Start Live Video دکمهٔ •
 .بگذارند کامنت و بپیوندند توانندمی فالوئرها •
 .(نفره دو) کنید اضافه ویدیویی  تماس به هم را  دوستان از یکی توانیدمی •
 . کنید  کلیک  End Live روی ختم، برای •

 

 

 IT رسانی و ابزارهای ارتباطاتآشنایی با اصطلاحات و مفاهیم در پیام

  استفاده   محتوا  گذاری اشتراک   و   هاتماس  ها، پیام  فرستادن  برای  مختلف  های روش  از   ما   امروز،   دنیای  در
 .بشناسیم را اصلی مفاهیم و اصطلاحات  باید بگیریم، یاد  بهتر اینکه  برای. کنیممی

1 .Email (ایمیل) 

Google Meet Zoom YouTube Microsoft Team 
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 چیست؟  ایمیل         •
 .شودمی بدل و رد ها سازمان یا  افراد بین اینترنت طریق از که است  الکترونیکی پیام

 :مهم اصطلاحات          
• Inbox: ها پیام دریافت صندوق 
• Sent: شده فرستاده هایپیام 

 
• Draftsهای ذخیره شده اما ارسال نشده: پیام 
• Attachment : فرستیم فایلی )عکس، سند، ویدیو( که همراه ایمیل می 
• Reply :  پاسخ دادن به یک پیام 
• Forward فرستادن یک پیام برای فرد دیگر : 

2. Texting  / پیام متنی(SMS ) 
 پیام متنی چیست؟        

 .شودپیام کوتاه متنی است که از طریق شبکه موبایل فرستاده می
 :اصطلاحات مهم          
• SMS  :  پیام کوتاه متنی 
• MMS : ای )با عکس یا ویدیو( پیام چندرسانه 
• Emoji  های احساسی مانندشکلک :(ایموجی                ) 
• Delivery Report :دهد پیام شما رسیده یا نهگزارشی که نشان می 

 
3. Messaging Apps رسان( های پیام)اپلیکیشن 

 پیام رسانهای انترنتی چیست؟
 :اصطلاحات مهم      

• Chat:وگوی متنی گفت 
• Voice Message :پیام صوتی 
• Group Chat  :دهندگروهی که چند نفر در آن پیام می 
• Broadcast :سان برای چند نفر )بدون گروه( ارسال یک پیام یک 
• Online / Offline : دهد که شخص در برنامه فعال است یا نهنشان می 
• Status / Story:    شودساعت حذف می  ۲۴متن یا عکس کوتاه که بعد از. 

 
4. Contacts and Groups  (هاگروه و مخاطبین ) 

Contacts        ( مخاطبین:) همکاران   و دوستان هایایمیل یا  ها شماره لیست. 
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   Groups  (ها گروه:) داشته تماس یا وگوگفت باهم توانندمی نفر چندین که  فضایی 
 .باشند
 :اصطلاحات مهم          
• Add Contact: دفترچه به ایمیل یا  شماره کردن اضافه 
• Contact List :مخاطبین  لیست 
• Create Group : جدید  گروه  ساختن 
• Admin (ادمین:) کند. می  مدیریت  و ساخته را  گروه که  کسی 

5. Video Calls (ویدیویی تماس) 
 تماس تصویری چیست؟      

 . بینندمی را  همدیگر صدای و تصویر  نفر چند  یا دو آن در که زنده ارتباط نوعی
 :اصطلاحات مهم          
• Video Call :تماس تصویری دو نفره 
• Video Conference  : جلسه تصویری با چند نفر 
• Mute : خاموش کردن صدا 
• Screen Share : به اشتراک گذاشتن صفحه موبایل یا کامپیوتر 
• End Call : ختم تماس 

 
6. General IT Communication Terms (ارتباطات عمومی اصطلاحات IT ) 

• Attachment (پیوست:) پیام.  یا ایمیل  به شده ضمیمه فایل 
• Link (لینک:) برد.می فایل یا صفحه یک  به را شما که اینترنتی آدرس 
• Notification (رسانیاطلاع:) دارید. جدید تماس یا پیام گویدمی که  هشدار  پیام 
• Spam (هرزنامه:) تبلیغاتی.  یا  ناخواسته هایپیام 
• Block (کردن بلاک:) فرد. یک  پیام یا  تماس از  جلوگیری 
• Privacy (خصوصی حریم:) یا پیام توانندمی کسانی چه کندمی  کنترل که  تنظیماتی  

 ببینند. را  شما اطلاعات
 فعالیت ها: 

 . دانش آموزان باید یک مخاطب را در موبایل های اندروید و آیفون برعلاوه در گوگل نیز علاوه کند. 1
 .  دانش آموز نحوه فرستادن ایمیل را در جمیل و یا نرم افزار دیگر تمرین نماید.2
. نحوه ارسال ایمیل همراه با فایل که چطور ضمیمه کند را تمرین نموده تمام مراحل را لیست  3

 نمایند.
. نحوه تماس تصویری در گوگل مییت، زووم و مایکروسافت تیم را تمرین نموده و مراحل هر کدام 4

 را لیست کنید؟
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. دانش آموز تمام اصطلاحات مربوط به ارتباطات را که در آخر رهنمایی آموزش داده شده است را  5
 حفظ کنند. 

 سوالات چالشی: 

 چطور در موبایل اندروید و آیفون یک مخاطب جدید ایجاد کنیم؟ .1
چطور در اپلیکشن گوگل میت تماس تصویری برقرار کنیم و لینک این جلسه را برای دیگران   .2

 بفرستیم؟ 
 تماس گروهی در واتسپ چگونه است؟ میتوانید روش آنرا لیست کنید!  .3
 صدا و همچنان صفحه خود را شریک کنیم؟چطور در تماس های تصویر تماس تصویر را بی .4
وقت ایمیل میکنیم اگر خواسته باشیم یک فایل)عکس، ویدیو، سند و یا هر چیز...( را چطور   .5

 در ایمیل ضمیمه کنیم؟ 
 

 درس چهارم 
 )انجام معاملات(  استفاده از خدمات آنلاین

 هدف آموزشی 
 :شاگردان باید بتوانند

 .مفهوم فورم آنلاین را بفهمند .1

 .نویسی( را یاد بگیرندخانه، عددیاجزای اصلی فورم آنلاین )خانه متن، لیست کشویی، تیک .2

را   (Verification checks) چک تأییدیو  (Data validation) اعتبارسنجی فرق میان  .3
 .تشخیص دهند

 .های آنلاین را درست پر کنندهای روزمره، فورمبا مثال .4

 فورم های آنلاین 
 فورم آنلاین چیست؟ 

 :تعریف
خواهد معلومات مشخصی وارد کنید. این فورم آنلاین یک صفحه ساده در انترنت است که از شما می

ت، ثبت نام تذکره، پاسپورت نام، درخواست خدمات، یا گرفتن وقت ملاقاثبتها معمولاً برای فورم 
 .شوندستفاده میو غیره ویزه... 
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 :هامثال

 نام در یک امتحان مانند امتحان تافل، و یا فورم درخواست کار ثبت •
 .گرفتن نوبت داکتر •
 .خانهزباله های آوری  درخواست برای جمع •
 .نام در یک وبسایت یا شبکه اجتماعی ثبت •

 اجزای فورم آنلاین 
 (a) Free-text cells .1  – خانه آزاد نوشتن 

 .توانید هر نوع متن یا عدد وارد کنیدها خالی هستند و شما میاین خانه •
 .نوشتن نام، آدرس خانه، ایمیل :مثال •
 .ها محدودیت دارند )مثلاً ایمیل باید شامل @ باشد(بعضی خانه     •

 – Drop-down lists  .2 لیست کشویی 
شود و شما فقط یکی را انتخاب ها باز میوقتی روی آن کلیک کنید، یک فهرست گزینه •

 .کنیدمی
 .انتخاب ولایت )کابل، هرات، بلخ، بامیان(  :مثال •
 .های درست داده شده استجلوگیری از اشتباه تایپی، چون فقط گزینه :مزیت  •

 Checkboxes / Tick boxes  .3 –  های تیک خانه 
 .برندارید یا  بگذارید ✔توانید علامت های کوچک که میمربع •
 :مثال •

o "من قوانین را قبول دارم". 
o "های تبلیغاتی دریافت کنمخواهم پیاممی". 

–Radio buttons  .4 های انتخابی دکمه 

 .شوداست ولی در یک گروه فقط یک گزینه انتخاب می Checkbox مثل •
 .(⭕ زن ⭕انتخاب جنسیت: )مرد  :مثال •

Numerical data entry .5 –    وارد کردن اعداد 

 .خواهند فقط عدد وارد کنیدها از شما میبعضی فورم  •



 
21 

 .(Calculator) گر آنلاینسن، تاریخ تولد، یا مقدار در یک محاسبه :مثال

• Data validation  کند تا مطمئن شود شما متن ننویسید اینجا کار می 

  
 

 بررسی درست بودن معلومات 

Data Validation   یا اعتبار سنجی اطلاعات در خانه پری فورمها 

 کند که معلومات درست وارد شده باشد:سیستم به صورت خودکار بررسی می

 .دهدخطا می →اگر باید عدد وارد کنید، ولی شما حروف نوشتید  •
 .دهدخطا می →اگر ایمیل نوشتید ولی علامت @ وجود ندارد  •
 .دهد فورم ارسال شوداجازه نمی → ای را خالی گذاشتید که ضروری است اگر خانه •

 .جلوگیری از اشتباه هنگام پر کردن فورم :هدف   

Verification checks   تاییدی یا چک 

 نمونه فورم آنلاین با تمام جزئیات ذکر شده
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 .گیرد تا مطمئن شود شما همان شخص هستیداین مرحله معمولاً بعد از ارسال فورم صورت می

 .آید و باید آن را وارد کنیدتان مینام، یک کود به موبایلبعد از ثبت :۱مثال  •
 .شودیک لینک تأیید به ایمیل شما ارسال می :۲مثال   •
 .وارد کردن رمز عبور دوباره برای تأیید :۳مثال  •

 .تأیید هویت کاربر یا درستی معلومات :هدف   

 مثال عملی ترکیبی 

 :نام کنیدثبت  آوری کثافات خانهجمع خواهید برای فرض کنید می 

 .شویدوارد وبسایت شهرداری می .1
 :شودفورم باز می .2

o خانه آزاد :نام –   Free Text 
o فقط عدد :شماره تماس Data Validation  
o د خانه آزا :آدرسFree Text 
o یا دراپ دوون  لیست کشویی:ولایتDrop-Down 
o  ✔ من شرایط خدمات را قبول دارم(Checkbox) 

 .آیدتان میرقمی به موبایل ۶ دبعد از کلیک روی "ارسال"، یک ک .3
 .(Verification check) کنیدرا وارد می دک .4
 .   درخواست شما موفقانه ثبت شد .5

 :خلاصه
 .شودمی استفاده خدمات گرفتن و  معلومات کردن وارد برای آنلاین فورم •
 .است عددی خانه و انتخابی دکمه خانه،تیک کشویی، لیست  متن، خانه شامل آن  اجزای •
• Data validation    معلومات صحت بررسی. 
• Verification check  کاربر هویت تأیید. 
 (. آنلاین  نام ثبت یا داکتر نوبت گرفتن مثل) کنند تمرین ساده  هایمثال با باید شاگردان •
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های پرداخت  خرید کالا یا خدمات از طریق اینترنت با استفاده از روش
 آنلاین امن

 خرید آنلاین به دو سبک انجام میشود:
با استفاده از کارتهای بانکی که در آن وب سایت قابل قبول است، یعنی از   پرداخت آنلاین؛ .1

 خدمات آن بانک برای پرداخت استفاده میکند. همه کارت ها در خرید آنلاین قابل قبول نیست. 

زمان مشتری جنس را سفارش میدهد گزینه تحویل درب منزل را  پرداخت در زمان تحویل دهی؛ .2
انتخاب میکند. دو امکان در این مورد وجود دارد یک: مشتری از اصالت جنس مطمئن نیست یا اینکه  

 کار برای پرداخت آنلاین ندارد. 

برای پرداخت آنلاین نکات امنیتی وجود دارد که باید رعایت شود. اخیرا در افغانستان فروشات آنلاین  
رواج پیدا کرده است اما روش دوم که پرداخت در زمان تحویل صورت میگرد بنا بر نبود زیرساخت  

 های حکومتی این روش ممکن نیست. 
  (Select item/service) : انتخاب کالا یا خدمات1مرحله 

 ,Amazon ،eBay ،Bahzahr.com )مثل شویدسایت یا اپلیکیشن فروشگاهی میابتدا وارد یک وب
Bazaroona.com ) 

ها، قیمت، رنگ  توانید ویژگیدر این مرحله می .کنیدخواهید بخرید انتخاب میکالا یا خدمتی را که می
 .و اندازه را مشخص کنید

 
 :مثال

کنید و آن را به  را انتخاب می   Samsung Galaxy S23 ، شما یک تلفن همراه Amazonسایتدر وب
 .کنیداضافه می (Cart) سبد خرید

 (View Cart / Checkout) : مشاهده سبد خرید2مرحله 
 :توضیح .1

 .شوید تا تمام اقلام انتخابی را مرور کنیدپس از انتخاب کالا، وارد قسمت »سبد خرید« می
 .توانید تعداد کالا را تغییر دهید یا کالایی را حذف کنیددر این بخش، می .2
 .شودهمچنین هزینه نهایی، مالیات، و هزینه ارسال نمایش داده می .3
 :مثال

 .دلار است  650بینید که در سبد خریدتان یک گوشی و یک قاب محافظ وجود دارد و قیمت کل  شما می
 (Enter shipping/billing details) : وارد کردن اطلاعات خریدار و آدرس3مرحله 
 :توضیح

 .برای تکمیل خرید، باید اطلاعات شخصی مانند نام، آدرس تحویل، شماره تماس و ایمیل را وارد کنید
 .شود، اطلاعات مالی و صورتحساب وارد می«Billing Information» همچنین در بخش
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Name: Farahmand Naimzad 
Address: Kabul, Afghanistan 
Phone: +93 79 000 0000 

farahamd@gamil.com: Email 

 (Choose method of online payment) : انتخاب روش پرداخت4مرحله 
 :توضیح

 های پرداخت آنلاین معمولاً شامل موارد زیر است: روش 

 مثال توضیح  پرداخت  نوع

Credit/Debit Card 
المللی وارد کردن اطلاعات کارت بانکی بین

 MasterCard یا Visa مانند
Visa Card از بانک 
AIB 

Third-party Payment 
Service 

 های واسطه ماننداستفاده از سرویس 
PayPal یا Stripe 

 پرداخت از طریق
PayPal 

Digital Wallet / Mobile 
Payment 

 پرداخت از کیف پول دیجیتال یا موبایل 
Google Pay  ،

Apple Pay ،M-Pesa 

Cryptocurrency  در برخی
 ها سایت 

 Bitcoin ،Ethereum پرداخت با ارز دیجیتال 

 

این خدمات بصورت جهانی قابل استفاده است شهروندان افغانستان اگر خواسته باشد از سایت آمازون یا علی  
 بابا خرید کند به یکی از این میتودها نیاز پیدا میکند.

 (Enter payment details) : وارد کردن اطلاعات پرداخت5مرحله 
 :توضیح

 :شوداگر کارت بانکی انتخاب کردید، اطلاعات زیر وارد می

• Card Number 
• Expiry Date 
• CVV Code 
• Cardholder Name 

شوید و پرداخت را  یا کیف پول دیجیتال، معمولاً فقط وارد حساب کاربری خود می PayPal در مورد
 .کنیدتأیید می

 :مثال

mailto:farahamd@gamil.com
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Card Number: 4111 1111 1111 1111 
Expiry: 12/27 
CVV: 123 
Name: Farahmand Naimzad 

 (Verify secure payment) : تأیید امنیت پرداخت6مرحله 
 :توضیح

 :خواهد، مثلدر این مرحله سیستم پرداخت از شما تأییدیه امنیتی می
 (OTP) بار مصرفورود رمز یک •
 (2FA) ایاحراز هویت دو مرحله •
 .است HTTPS امن اتصال دهندهنشان که  آدرس نوار در(    یا استفاده از نماد قفل )  •
 :مثال

 :کندبانک برای شما پیامک ارسال می
“Your OTP for online purchase is 654321” 

 (Purchase Confirmation) : دریافت تأیید خرید7مرحله 

 :توضیح
 .شودنمایش داده می ”Payment Successful“ای با پیام پس از پرداخت موفق، صفحه

 (Order ID) کنید که شامل جزئیات خرید و شماره سفارشهمچنین یک ایمیل تأیید دریافت می
 .است

 :مثال

Email Subject: Your Order #123456 has been confirmed 
Delivery: Estimated in 3–5 business days. 

 (Complete online purchase securely) : رعایت نکات امنیتی در خرید آنلاین8مرحله 

 :توضیح
 :برای اطمینان از خرید امن باید

 .استفاده کنید  //:httpsهایی با آدرس همیشه از سایت .1
 .فای عمومی برای خرید استفاده نکنیداز وای .2
 .های ناشناخته وارد نکنیداطلاعات کارت بانکی را در سایت .3
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 .رسید و تأیید پرداخت را ذخیره کنید .4

 :مثال
 .باشد داشته وجود    قبل از وارد کردن شماره کارت، بررسی کنید که در نوار آدرس مرورگر علامت  

 خلاصه کاربردی 

 مثال  هدف مرحله شماره

 تاپانتخاب لپ گیری برای خرید تصمیم  انتخاب کالا 1

 مشاهده هزینه کل بررسی نهایی اقلام  سبد خرید  2

 آدرس کابل تعیین مقصد ارسال  اطلاعات آدرس 3

 PayPal انتخاب PayPal انتخاب بین کارت یا روش پرداخت  4

 ورود شماره کارت  پرداخت واقعی وارد کردن جزئیات  5

 OTP رمز جلوگیری از سوواستفاده تأیید امنیت 6

 ایمیل تأیید  اطمینان از موفقیت تراکنش تأیید خرید  7

 خرید از سایت امن  محافظت از اطلاعات  رعایت امنیت  8

 

ها و نکات امنیتی برای خرید اینترنتی مطمئن و جلوگیری از  روش
های آنلایناستفادهسوء  

 برسی اصالت وب سایت  .1
 :توضیح

 کنید واقعیسایتی که از آن خرید می پیش از وارد کردن اطلاعات بانکی یا شخصی، باید مطمئن شوید وب 
(genuine) است، نه جعلی (fake) یا فیشینگ (phishing). 

 :نکات بررسی
 ( Secureیعنی  s)  یعنی شروع شود   //:httpsآدرس سایت باید با  •
 .باشد داشته وجود باید    در کنار آدرس سایت، علامت قفل  •
هایی  های جعلی معمولاً از آدرسسایترا دقیق بررسی کنید؛ وب (Domain Name) نام دامنه •

 .کنندشبیه سایت اصلی استفاده می
•   amaz0n-shop.com   جعلی 
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•    amazon.com → اصلی 

 :مثال
  nike.com، باید بررسی کنید که این سایت رسمی «Nike-online-discount. Shop» قبل از خرید از

 .دهنده باشدنیست و ممکن است فریب

 
2 .Set a strong password on your online account   تنظیم رمز عبور قوی برای(

 حساب آنلاین( 

 :توضیح
پول دیجیتال باید از رمزهای عبور قوی  های فروشگاهی یا کیفبرای ورود به حساب کاربری در سایت

 .استفاده شود تا از سرقت اطلاعات جلوگیری شود

 :های رمز قویویژگی

 کاراکتر  12تا  8حداقل  •
 (%$#@!) ( و نمادها9–0، اعداد )(a–z) ، حروف کوچک(A–Z) شامل حروف بزرگ •
 بدون استفاده از نام، تاریخ تولد یا شماره تلفن •

 :مثال
     *Na!mZ@d2025 :رمز قوی

     naimzad123 :رمز ضعیف 

3 .Avoid saving card details on shared devices ی هادستگاه یاطلاعات کارت رو رهی)عدم ذخ  
 مشترک( 

 :توضیح
 .دهد اطلاعات کارت را ذخیره کندهنگام خرید، مرورگر معمولاً پیشنهاد می

 .کنید، هرگز این گزینه را نپذیریداگر از کامپیوتر عمومی یا تلفن دیگران استفاده می

 :مثال
 .کنید خاموشرا  ”Save card for future use“ نت یا کتابخانه عمومی، گزینهدر کافی

4.  Use two-factor authentication ( یادو مرحله تی )استفاده از احراز هو 

 :توضیح
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ی امنیتی است که علاوه بر رمز عبور، از طریق پیامک یا  ی اضافه یک لایه  (2FA) ایاحراز هویت دو مرحله 
 .کنداپلیکیشن کد تأیید ارسال می

 .شود حتی اگر کسی رمز شما را بداند، نتواند وارد حسابتان شوداین کار باعث می 
 :مثال

 فرستد تا تأیید کنید. رقمی به گوشی شما می 6شوید، سیستم یک کد می PayPalوقتی وارد حساب 
5. Avoid clicking suspicious links or pop-up   ایمشکوک  یها نکیل ینکردن رو  کی)کل  

 ها( آپپاپ

 :توضیح

هایی جعلی داشته باشند که برای سرقت اطلاعات  ها یا تبلیغات آنلاین ممکن است لینک برخی ایمیل 
 .اندساخته شده 

 .های ناشناخته وارد صفحه پرداخت نشویدهرگز از طریق لینک 
 :مثال

”، روی لینک آن  You won a free iPhone! Click here to claimاگر ایمیلی دریافت کردید با عنوان “
 کلیک نکنید. 

6 .Keep device and browser updated   دستگاه و مرورگر(  یروزرسان)به 
 :توضیح

 .کنندروزرسانی جدید، اشکالات امنیتی را برطرف می ها با بهعامل مرورگرها و سیستم 
 .را استفاده کنید (Chrome ،Edge ،Firefox مثل) همیشه آخرین نسخه مرورگر

 :مثال
 های امن را باز نکند. پشتیبانی نکند و سایت HTTPSنسخه قدیمی مرورگر ممکن است از پروتکل 

7  .Review your bank statements regularly (یبانک  یها منظم تراکنش ی)بررس 
 :توضیح

های  پس از خرید آنلاین، هر چند روز حساب بانکی خود را بررسی کنید تا مطمئن شوید پرداخت 
 .غیرمجاز انجام نشده است

 :مثال
 ” دیدید، فوراً با بانک تماس بگیرید. Unknown Paymentها مبلغی با عنوان “ اگر در لیست تراکنش 

 

 خلاصه نکات امنیتی خرید آنلاین 

 مثال  توضیح  اقدام امنیتی شماره

های بافقط از سایت بررسی آدرس سایت  1  HTTPS 
 amazon.com    استفاده کنید 

 *Na!mZ@d2025 ترکیب حروف، عدد، نماد رمز قوی بسازید  2
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نت کافی   مخصوصاً در کامپیوتر عمومی  عدم ذخیره کارت 3  
ای احراز هویت دو مرحله 4  PayPal 2FA      یا اپ  SMS کد تأیید از طریق 

های  اجتناب از لینک 5
 مشکوک

روی تبلیغات جعلی کلیک 
 free-gift.com   نکنید 

روزرسانی مرورگر به  6 های امنیتی رفع حفره      Chrome 2025 
ها بررسی تراکنش 7 های غیرمجاز شناسایی پرداخت         Bank Alert 

 

 

 سوالهای چالشی:

 فورم های آنلاین بخاطر یکی از مقاصد ذیل استفاده میشود؟  .1
مانند نام و تخلص...  را وارد میکنیم و آزاد و هر نوع   یکی از بخش فورم های آنلاین که اطلاعات خود .2

 نام ببرید؟  دیتای متنی را نوشته میتوانیم
کشور را که به    200در صورت که یک لیست طولانی از موارد انتخابی داشته باشیم بطور مثال لیست  .3

 مخاطب اجازه بدهیم کشور مورد نظر را انتخاب کرده بتواند از کدام بخش فورم باید استفاده کنیم؟ 
 در فورم ها معمولاً کدام نوع دیتا اعتبار سنجی میشود؟  .4
برای تأیید بعضی قوانین مربوط به خدمات، همان سایت یک چک تأیید را در آخر فورم قرار میدهد که   .5

بعد خانه پری تمام خانه های خالی باید آن چک را نیز بگذارید بعنوان تأییدی آخری مرحله که آن چک  
 را به یکی از نام های ذیل یاد میکند.

معمولاً پرداخت خرید آنلاین بدو صورت انجام میشود به این دلیل که مشتری به صحت جنس اعتماد   .6
را  ندارد یا هم شیوه خرید کارت بانکی ندارد و ترجیح میدهد به روش دام انجام دهد. لذا این روش 

 مرحله به مرحله یاداشت کنید؟
برای خرید محصول در وب سایت های آنلاین در گام اول باید چی چیز را انجام بدهم تا یک محصول   .7

 را خریداری نمایم؟ 
بعد از انتخاب محصول مورد نظر ما در کدام یکی از گزینه های ذیل انتقال پیدا میکند تا ما براحتی  .8

 بتوانم روش پرداخت را انجام دهیم؟ 
برای اینکه محصول انتخاب شده در سبدخرید نمایش داده شد باید کدام اطلاعات را به فورم که برای   .9

 ما نشان داده میشود بدهیم تا مرحله پرداخت تکمیل شده و این مرحله بنام چی یاد میشود؟ 
همانطوریکه شما میداند ما دو نوع پرداخت برای خرید کالاها از انترنت داشتیم یکی پرداخت آنلاین و   .10

دیگری پرداخت درب منزل در صورتیکه پرداخت آنلاین را انتخاب کنیم و کارت کانکی شامل کدام  
 اطلاعات میشود که ما آنرا در فورم پر نمایم؟ 
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 پنجم درس 
 )استفاده مصئون از انترنت(  ایمن و مسئول بودن در فضای آنلاین

 :هدف درس
 :آموز یاد بگیرددانش 

 شود. اش ذخیره میکجاها اطلاعات شخصی .1
 چطور از اطلاعات و حریم خصوصی خودش محافظت کند.  .2

 مفهوم کلی 

 .امروز جهان ما با »انترنت« و »تکنولوژی« پیوند خورده است •

 .وگوبرای درس، بازی یا گفت —کنیم هر روز ما از تلفن، تبلت یا کمپیوتر استفاده می •
گونه که در دنیای واقعی باید محتاط بود، در دنیای مجازی نیز باید با آگاهی و احتیاط  اما همان •

 .قدم گذاشت
های خوب وجود دارند و هم زیرا دنیای آنلاین مانند یک شهر بزرگ است که در آن، هم انسان •

 کنند. کسانی که از ناآگاهی دیگران سوواستفاده می

 یا اطلاعات شخصی:  Personal Informationمعنی  .1
 :شما کی هستیددهد  اطلاعات شخصی یعنی چیزهایی که نشان می

 ً  :مثلا
                         نام و نام خانوادگی •
        شماره تلفن •
         آدرس خانه •
          ها یا ویدیوهاعکس •
     (Location) موقعیت مکانی •
      (Password) رمز عبور •
       های آنلاینکارت بانکی یا حساب •

 :احتیاطیپیامد بی 

 :اگر این اطلاعات به دست افراد ناشناس بیفتد، ممکن است

 از هویت شما سوواستفاده کنند )خود را به جای تو معرفی کنند(  •
 رمزهایت را بدزدند. •
 هایت را در جاهای نادرست پخش کنند. یا عکس •
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 شود؟ کجا این اطلاعات ذخیره می  .2
 .ماندگیری، مکان و زمان آن در حافظه میوقتی عکسی می •
 .شودات ذخیره میکنی، سابقهوجو میوقتی در مرورگر چیزی جست •

 :هادر دستگاه 
 .شودگیری، تاریخ و مکان عکس ذخیره میوقتی با گوشی عکس می •
 .شودی جستجویت ذخیره میکنی، سابقهوقتی در مرورگر جستجو می •
 .کنی، ممکن است به دوربین، میکروفون یا مکان تو دسترسی بگیردای نصب میوقتی برنامه •

 :های آنلاین در فعالیت 
 .سازیدها حساب کاربری میوقتی در سایت •
 گذاریدهای اجتماعی پست یا عکس میوقتی در شبکه •
 کنیداستفاده می TikTok یا  Google  ،Facebook ،YouTube وقتی از •

ی  کنند تا تبلیغات مخصوص تو نشان دهند یا تجربهها اطلاعات تو را جمع میاین سایت
 .کاربری را تغییر دهند

 :احتیاطی پیامد بی
 .ها از اطلاعاتت برای مقاصد تجارتی یا تبلیغاتی استفاده کنندکه بدانید، برنامهممکن است بدون آن

 .برندهایت بهره میگاهی نیز هکرها از همین اطلاعات برای نفوذ به حساب
 

 :هاالف( در دستگاه
 .ترکیبی از عدد، حروف بزرگ و کوچک  —بگذار  رمز قویهمیشه  .1
 .از گوشی یا کمپیوتر بدون قفل استفاده نکن .2
برای کمپیوتر سیستم عامل   App Store یا    Play Store( ) منبع مطمئنها را فقط از  برنامه  .3

 را نصب کنیم که قابل اعتماد میباشد.   Microsoft Storeویندوز 
 .بدون نیاز استفاده نکن عمومی Wi-Fiاز  .4

 :اگر رعایت نکنی
ات استفاده  های اجتماعی هایت را ببیند، یا حتی از حساب ها و پیامتواند وارد دستگاهت شود، عکس کسی می 

 .کند
 :های اجتماعی ب( در شبکه

 .نگو—دوستان نزدیکت even—کسرمز عبورت را برای هیچ .1
 .درخواست دوستی از افراد ناشناس را قبول نکن .2
 .را فعال کنحریم خصوصی    Privacyدر تنظیمات، بخش  .3
 .(Log out) خارج شووقتی کار کردی، از حساب خود  .4
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 .ها یا موقعیت زنده خودداری کناز گذاشتن عکس .5
 :اگر رعایت نکنی

 ها یا اطلاعاتت برای تهدید، تمسخر یا دزدی هویت استفاده کند. ممکن است کسی از عکس

  رفتار مسئولانه در دنیای دیجیتال .3

  با ادب، احترام و آگاهیاما فقط برای کسانی که    —دنیای آنلاین جای یادگیری، دوستی و پیشرفت است  
 .از آن استفاده کنند

 .تواند برای همیشه باقی بماندکنید، میهر نوشته و عکسی که نشر می  
 شود؟« خطر است؟ آیا باعث آزار کسی نمیقبل از نشر هر چیز، فکر کن: »آیا بی  
یا   یدتر یا مسئول مکتب اطلاع بدهبه بزرگاگر کسی در فضای آنلاین رفتار نادرست داشت،   

 .و وارد بحث نشویدوالدین خود در میان بگذارید 

 :مسئولیت باشی اگر بی 
ممکن است اعتماد دیگران را از دست بدهی، دچار استرس یا آزار آنلاین شوی، و یا حتی دچار  

 .مشکلات قانونی گردی

 نتیجهٔ نهایی       

اگر با دقت از آن پاسداری  .ات استحفظ امنیت در انترنت مانند نگهداری از کلید خانه 
احتیاط باشی،  اما اگر بی.ای از علم و فرصت خواهد بودکنی، دنیای دیجیتال برایت دریچه 

 .تواند خطرناک شودهمان دنیای زیبا می 

 :پس همیشه
 آگاه باش، محتاط باش، و با احترام از دنیای آنلاین استفاده کنید!

 های ساده برای حفظ حریم خصوصی استفاده از مرور خصوصی و روش  .4
کند، اطلاعاتی از تو ذخیره می  (Browser) کنی، مرورگرگاهی وقتی از انترنت استفاده می 

)مرور    Private Browsingاما    .ایهایی که باز کردی یا رمزهایی که وارد نموده مثل سایت 
 کند که این اطلاعات در حافظه باقی نماند. خصوصی( کمک می 

 :های ساده محافظت از اطلاعات شخصیروش
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 :  Incognito Modeیا  (Private Mode)استفاده از مرور خصوصی .1
هایی که دیدی را ذخیره وقتی این حالت را فعال کنی، مرورگر تاریخچه، رمزها یا سایت

 .کندنمی
مرور خصوصی را باز   Ctrl + Shift + Nتوانی با فشردن می Google Chrome مثال: در     
 .کنی

 :پنهان نگه داشتن تاریخ تولد و شماره تماس در فضای آنلاین .2
 .یا بخش دید عمومی ننویس (Bio) ها، بیووقت این اطلاعات را در پستهیچ
ها برای حدس زدن رمزها یا جعل هویت  توانند از همین داده چون افراد ناشناس می    

 .استفاده کنند
 :(Pseudonym) استفاده از نام مستعار .3

توانی از یک نام غیرواقعی و محترمانه استفاده کنی تا هویت  های اجتماعی میدر شبکه
 .ات پنهان بمانداصلی
 .”TechStudent21“ بنویس ”Ahmad Habibi“ جایمثال: به    

 :(HTTPS) سایت بررسی آدرس وب .4
خواهی رمز، نام کاربری یا اطلاعات شخصی وارد کنی، نگاه کن آدرس سایت  همیشه وقتی می

 شروع شود،  //:httpsبا 
 .است امنیعنی  ”secure“ به معنی  sچون حرف 

 :(Blocking Unwanted Communications) مسدود کردن ارتباطات ناخواسته .5
 .کن  Reportیا   Blockاگر کسی پیام مشکوک یا آزاردهنده فرستاد، او را فوراً 

 .وگو نکنگاه با افراد ناشناس در اینترنت گفتهیچ    
 :پیامد رعایت نکردن این موارد

 .ات ممکن است دزدیده شوداطلاعات شخصی •
 .تواند هک شودات میهای اجتماعیحساب •
 .ممکن است مورد آزار یا تهدید آنلاین قرار بگیری  •
 .حتی گاهی ممکن است از نام یا عکس تو در کارهای نادرست استفاده شود •

 گذاری اطلاعات شخصیپیامدهای اشتراک. 5

کنی )مثل عکس، شماره، یا  صورت عمومی نشر میات را در اینترنت بهوقتی اطلاعات شخصی
ای از آن خواهند  دانی چه استفادهگذاری که نمیموقعیت(، در واقع آن را در اختیار افراد ناشناسی می

 کرد.
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 :ی مهمچند نکته  

 .گذاری، ممکن است برای همیشه بماندهرچه در اینترنت می .1
 .حتی اگر حذفش کنی، ممکن است در جایی ذخیره شده باشد

 .اشتراک عکس یا آدرس شخصی خطرناک است .2
 .هایت استفاده کندتواند از آن برای پیدا کردن موقعیت یا هک کردن حسابکسی می

 .کنندها از اطلاعاتت برای تبلیغات یا فروش استفاده میگاهی سازمان .3
هایت را  شوی، ممکن است دادهای عضو میکنی یا در شبکهمثلاً وقتی در سایتی خرید می

 .های مخصوص به تو استفاده کنندبرای تبلیغ
 .کار رودتر بههای بزرگتواند برای سوءاستفادهاطلاعاتت می .4

 .(Phishing) های دروغینیا تهدید از طریق پیام (Identity Theft) مثل دزدی هویت

 :احتیاط اطلاعاتپیامد اشتراک بی 

  از بین رفتن حریم خصوصی •
  دزدی هویت یا حساب بانکی •
  های خطرناکها و لینکدریافت پیام •
  آسیب روحی و روانی از تهدید یا تمسخر آنلاین •

 :نتیجه نهایی  
 استفاده شود، دنیای دانش و دوستی است، عقل، ادب و احتیاطدنیای آنلاین اگر با 

 .تواند خطرناک شودفکر در آن گام بگذاریم، میاما اگر بی

 :پس همیشه به یاد داشته باش

 .اطلاعاتت، گنج توست
 هرگز نگذار کسی بدون اجازه به آن دست پیدا کند. 

 سوالات چالشی: 

 اطلاعات شخصی شما چیز میشود؟ آنها را لیست کنید. .1
اگر شخصی خود را اکوونت آنلاین با دیگران شریک کنیم چی خطرات امنیت دیجیتالی شما و   .2

 همچنان هویت را تهدید میکند؟
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اگر بی احتیاطی کنید و از اطلاعات خود محافظت نکنید ممکن است چی خطرات شما را تهدید   .3
 کند و پیامد آنرا لیست کنید.

 اطلاعات ما در کجا ذخیره میشود تمام این موارد را لیست کنید.  .4
( کدام ها اند؟ نام Browserروشهای ساده برای محافظت از معلومات شخصی در جستجوگرها ) .5

 ببرید
6. HTTPS  چیست و خلاصه شرح بدهید؟ 
 پیامد شریک سازی اطلاعات شخصی را لیست کنید.  .7

 ششم درس 
 :حفاظت از دیتا در فضایی آنلاین و آفلاین

 (نی)آنلا نترنتیاستفاده مصئون و مسئولانه از ا 
  های درس  و  پیام  بازی،  عکس،   ما   .شودمی  انجام  اینترنت  و  تاپلپ  موبایل،  با  ما   کارهای   بیشتر  امروز
را   ما  اطلاعات  بخواهند  است  ممکن  هابرنامه  یا  افراد  بعضی  اما  .داریممی  نگه  این دستگاه    در  را  خود

 . کنیم  محافظت  خود  هایدستگاه  و  از دیتاها  چطور  بگیریم  یاد  باید  دلیل  همین  به  .کنند  خراب  یا  بدزدند
 

 آنلاین  تهدیدهای و خطرات
استفاده می اینترنت  از  ندارددکنیوقتی  وجود  امنیت  برنامه  .، همیشه  یا  افراد  است  برخی  ممکن  ها 

 گویند. می (Online Threat) به این کار تهدید آنلاین .را بگیرند شمابخواهند اطلاعات 
 :هامثال
 :اگر کسی برایت ایمیل یا پیام فرستاد و گفت •

 .باشد ممکن است ویروس یا فیشینگ این   !برای بردن جایزه کلیک کن 
ً اگر در وای • میدان هوایی و مکانها عمومی که خدمات  یا   رستورانت، کتابخانه :فای عمومی )مثلا

 ،د( وارد حساب خود شویرایگان انجام میدهند
 .رمزت را ببیند ها ممکن است هکر 

 .شوندراحتی وارد حسابت می، دیگران به1234مثل  داگر رمز ساده بگذاری •
 

 شخصی  اطلاعات
 .شودمی مربوط  خودت به فقط که  چیزهایی  یعنی شخصی اطلاعات

 :مثل •
 نام کامل 
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 شماره تلفن •
 ها عکس •
 ها رمز حساب •
 آدرس خانه •

 . توانند سوواستفاده کننداگر این اطلاعات دست افراد اشتباه بیفتد، می
 بطور نمونه:

جای تو معرفی کند، ممکن است برای دیگران پیام  اگر کسی شماره تلفنت را بگیرد و خودش را به
 !بفرستد یا پول بخواهد

 دیتا  و دستگاه از محافظت هایروش
 :بماند امان در  اطلاعاتت تا  کند کمک تواندمی  ساده کار چند

  ویروس استفاده از آنتی 
 .گیردها را میویروس مثل سپر است که جلوی ویروسآنتی •
 Windows Defender ،Avast:مثال •
  استفاده از رمز قوی (Strong Password) 

 .از حروف، عدد و علامت با هم استفاده کن •
 .است 1234بهتر از   Rezvan@2025ل: مثا •
  قفل صفحه (Screen Lock) 

 .تاپت را قفل بگذار تا کسی بدون اجازه باز نکندگوشی یا لپ •
  فای عمومی دوری از وای 

 .های رایگان ممکن است ناامن باشندفایوای •
 .نیدهای عمومی اطلاعات مهم وارد نکدر مکان •
   ید ها باشها و لینکمواظب ایمیل 

 .نیدهر پیامی را باز نک •
 .هایی کلیک کن که مطمئنی واقعی هستندفقط روی لینک •

 

 فای عمومی خطرات وای
  را شبکه همان هم دیگران است ممکن  کنی،می  استفاده رایگان  فایوای  از وقتی

و به تمام منابع تو دسترسی   بخوانند را تو  رمزهای یا هاپیام  توانندمی  نتیجه در.ببینند 
 داشته باشند. 
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 جدول مرور مفاهیم 

 
 مثال معنی ساده  اصطلاح 
Virus  کندها را پاک میفایل آلوده که بازی کنندهبرنامه خراب 

Hacker  زند کسی که رمز موبایل تو را حدس می  دزد اطلاعات 
Phishing  گوید "رمز کارت را بدهایمیلی که می  پیام جعلی برای فریب!" 

Public Wi-Fi شاپ فای میدان یا کافی وای فای رایگان عمومیوای 
Strong 

Password 
 Amina@2025 رمز قوی

 
 های حفاظتجدول روش
 مثال توضیح  روش 

 Windows Defender نصب هاجلوگیری از ویروس  ویروس آنتی
 استفاده از عدد و حروف  جلوگیری از ورود دیگران  رمز قوی

 یا اثر انگشت  PIN امنیت موبایل  قفل صفحه 
 های مشکوکباز نکردن پیام  جلوگیری از فیشینگ  هادقت در ایمیل 

 استفاده از شبکه خانگی جلوگیری از دزدی اطلاعات  فای امن وای
 

 ها و خدمات آنلاین دسترسی امن به دستگاه
Access devices securel   مثل:)  هادستگاه  به  شدن  وارد  برای  امن  هایروش  از  استفاده  یعنی  

   Gmail،  Facebook،  Google Classroom مثل آنلاین  های حساب  و (  تبلت  یا   تاپلپ  موبایل،
 .شود تاناطلاعات و هاحساب وارد اجازه بدون نتواند شما از غیر  کسی شودمی باعث کار غیره. این و
 
 

  ساده توضیحات
  مراقب   اگر   اما .  خرید  و  سرگرمی   تا   گرفته  آموزش  از  .میشود  انجام  اینترنت  با   کارها  بیشتر   امروزه

  را   ما  اطلاعات  و  شوند  ما  آنلاین  حساب  یا  موبایل  وارد  است  ممکن  ناشناس  افراد  یا   هکرها  نباشیم،
 .ها استفاده کنیمها و حسابچگونه با امنیت بالا از دستگاهبرای همین باید یاد بگیریم   . کنند سرقت
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 نمونه های که روزانه از استفاده میکنید: 

 روش امن  وضعیت 
 باید رمز قوی بگذارید یا از اثرانگشت استفاده کنید  شود گوشی شما بدون رمز باز می

 شویدمی  Gmail وارد حساب
ای استفاده  از رمز قوی و احراز هویت دو مرحله

 کنید
 وارد حساب بانکی یا شخصی نشوید کنیدفای عمومی در کافه استفاده میاز وای

 کنیدپیام ناشناس حاوی لینک دریافت می 
روی لینک کلیک نکنید، ممکن است فیشینگ  

 باشد
تاپ خود را در جای عمومی رها  گوشی یا لپ 

 کنیدمی
 دستگاه را قفل کنید تا دیگران وارد آن نشوند 

 
 خطرات  و تهدیدها

 (:Virusس )ویرو
 .کندشود و آن را خراب یا کند میای است که وارد دستگاه میبرنامه یا فایل آلوده

 .شودهای شما میفایل بازی رایگان که از سایت ناشناس دانلود شده و باعث حذف فایل :مثال  
 

 (: Phishingگ )فیشین
 .خواهدکند که یک شرکت واقعی است و از شما رمز یا اطلاعات شخصی میوقتی کسی وانمود می

 .گوید رمز خود را وارد کنید، اما در واقع جعلی استآید که میایمیلی از »بانک« می :مثال  
 

 (Hack):هک کردن
 .شودوقتی کسی بدون اجازه وارد حساب یا سیستم شما می

 .دهدشود و رمز را تغییر میکسی از راه دور وارد اکانت فیسبوک شما می:  مثال  
 

 آنلاین  خدمات  و های دستگاه  از استفاده برای امن  روشهای
 

 مثال توضیح ساده  روش

 استفاده از رمز قوی 
رمز باید ترکیبی از حروف، اعداد و 

 ها باشدنشانه
Example123! 
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استفاده از اثرانگشت یا  
 تشخیص چهره 

برای ورود سریع و امن به موبایل یا  
 ها برنامه 

 Face باز کردن گوشی با 
ID 

 ایاحراز هویت دو مرحله
(2FA) 

علاوه بر رمز، کد امنیتی به گوشی  
 شودشما ارسال می

 SMS با Gmail ورود به
code 

 جلوگیری از ورود ویروس و هکرها  ویروس و فایروالنصب آنتی
 Windows استفاده از

Defender 

 بروزرسانی سیستم 
آپدیت باعث برطرف شدن مشکلات  

 شودامنیتی می
Update  ویندوز یا اندروید 

های  عدم کلیک روی لینک
 ناشناس 

 ها جعلی هستندبسیاری از لینک
لینک در پیام ناشناس  

 واتساپ

 قفل کردن دستگاه 
تاپ را با رمز  همیشه موبایل یا لپ
 قفل کنید 

 ً  در مکان عمومی مخصوصا

 
 
 

 جدول خلاصه اصطلاحات  
بعضی اصطلاحات در بخش انترنت و امنیت وجود دارند که دانش آموزان باید آن را به خاطر بسپارند و 

 کاربرد آنرا نیز بدانند:

 مثال  معنی ساده اصطلاح 
Password  رمز رمز عبور برای ورود به سیستم یا حساب Gmail 
Fingerprint حسگر انگشت گوشی  اثر انگشت برای باز کردن دستگاه 

Facial 
Recognition 

 باز کردن قفل گوشی با چهره شناسایی چهره 

Virus  فایل آلوده از اینترنت  کننده سیستم برنامه خراب 
Phishing  ایمیل جعلی بانکی تلاش برای سرقت اطلاعات 
Hacking  هک حساب فیسبوک  ورود غیرمجاز به سیستم 

2FA  رمز دوم پیامکی هنگام ورود  ایامنیت دو مرحله 
 
 

 .های آنلاین بسیار مهم استها و حسابهای امن برای استفاده از دستگاهیادگیری روش •
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اثرانگشت، و کلیک نکردن روی   • از  با رعایت چند نکته ساده مثل گذاشتن رمز قوی، استفاده 
 های ناشناس، لینک

 .های آنلاین خود محافظت کنیمها و حساباطلاعات شخصی، عکستوانیم از می •
 

 :آموزانپنج سؤال چالشی برای دانش 

«  اگر کسی برایت ایمیل بفرستد و بگوید »برای دریافت جایزه، روی این لینک کلیک کن :سؤال   
 دهی؟چه کاری انجام می

 .(phishing) تشخیص حملات فیشینگ :هدف
 نباید روی لینک کلیک کرد؛ باید فرستنده بررسی شود( پاسخ درست:)

 چرا نباید رمز خود را به دوستت بگویی، حتی اگر به او اعتماد داری؟: سؤال   
 .(privacy) درک مفهوم حفظ حریم خصوصی :هدف

 (.: چون ممکن است ناخواسته رمز پخش شود یا حساب ما دچار مشکل شودپاسخ درست)

کنی، چه کاری باید انجام دهی تا  شاپ( استفاده میعمومی )مثلاً در کافی Wi-Fi وقتی از  :سؤال   
 اطلاعاتت امن بماند؟ 

 .های حفاظت آزاد و روش Wi-Fi شناخت خطر  :هدف
 (رمزدار استفاده کنیم، اطلاعات شخصی وارد نکنیم Wi-Fi از پاسخ درست:)

 ات را چند دقیقه به کسی بدهی تا عکس بگیرد،فرض کن گوشی :سؤال   
 اگر قفل صفحه نداشته باشی، چه اتفاقی ممکن است بیفتد؟

 .(screen lock) اهمیت قفل صفحه  :هدف
 (هایم دسترسی پیدا کندها یا پیامممکن است به اطلاعات، عکس پاسخ درست:)

 ی مشکوک وجود دارد؟ توانی بفهمی که در موبایلت ویروس یا برنامهچطور می :سؤال   
 .های خطرویروس و نشانهآشنایی با نقش آنتی :هدف

 ( دهدویروس هشدار میآید، یا آنتیشود، تبلیغات زیاد میپاسخ درست: گوشی کند می)
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 فصل سوم 
 تولید محتوا، فریلنسر

 
 فریلنسر چیست )تعریف + مثال(

 :تعریف
  انجام مشتری  برای  را کار یک  بار  هر  بلکه کند؛نمی کار مشخص اداره یک برای که  است کسی   فریلنسر

 . گیردمی  پول آن  بدل در و دهدمی
 :مثال ساده 

گیرد، اما در هیچ  نویسد و پولش را میمثل یک شاگرد خطاطی که برای هر نفر یک کارت عروسی می
 .کنددکانی ثابت کار نمی

 :مثال فنی 
سازد و پول  می ، ایدیت صدا، ویدیو بلند و کوتاهیک طراح گرافیک که برای مشتری در انترنت یک لوگو

 .گیردمی

 جدول لغات
 معنی کوتاه  کلمه 

Freelancer کند شخصی که آزادانه کار می 
Client  مشتری 

Project  یک کار مشخص 
Payment  شده پول دریافت 
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 فریلنسری   و اداری کار تفاوت( 2

 :تعریف
کار اداری یعنی هر روز در یک اداره مشخص کار کردن؛ فریلنسری یعنی در خانه یا هرجا که خواستی،  

 .با اینترنت کار کردن

 :مثال ساده
 .کنداما فریلنسر هر وقت بخواهد کار می—رود بانکمی ۸کارمند بانک هر روز ساعت 

 :مثال فنی
 نماید. نویس فریلنسر فقط آنلاین کار مینویس اداری باید در دفتر باشد؛ اما برنامهبرنامه 

 

 لغات  جدول

 معنی  کلمه 
Office Job  کار اداری 

Remote Work  کار از راه دور 

Schedule  بندی کاری وقت 

 
 فریلنسری  شروع برای لازم  هایمهارت ( 3

 :تعریف
 .چیزهایی که باید بلد باشی تا بتوانی کار آنلاین بگیری

 :های سادهمهارت
 کمی تایپ بلد بودن  •
 استفاده از موبایل و کمپیوتر •
 داشتن حساب ایمیل •
 ارتباط مؤدبانه  •

 
 :مثال ساده

 .تر است نویسد، یک قدم نزدیکاپ درست پیام میآموزی که با واتسدانش 
 :مثال فنی

 .های سادهبرای ساخت پسُت Canva افزاری مثلداشتن مهارت در نرم 
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 معنی کلمه 
Skill  مهارت 

Typing  تایپ کردن 

Communication  ارتباط 

 
 چیست؟  محتوا تولید( 4

 :تعریف
 .سایت وب یا  اجتماعی  های شبکه برای صدا یا ویدیو عکس،  نوشته، ساختن
 :ساده مثال
 .محتواست این گذاری، می فیسبوک در  و گیریمی باغ از ویدیو یک موبایل  با وقتی
 :فنی  مثال

 .تجارتی صفحه یک برای محصول  معرفی  پسُت یک نوشتن
 

 معنی کلمه 
Content  محتوا 

Creator تولیدکننده 

Post  پسُت در شبکه اجتماعی 

 
 محتوا  تولید انواع( 5
 .مثل نوشتن یک توضیح کوتاه زیر عکس: متنی 

 و پوسترها  شده شده یا ویرایشطراحی ؛عکس: تصویری
 : برای شبکه های اجتماعی و تبلیغات های تلویزیونی.های کوتاهساخت کلیپ: ویدئویی 
 ؛ ایدیت صدا برای پاکست ها انستاگرام و یوتیوب مثل پادکست: صوتی 

        نوشتن یک جمله شیرین زیر عکس صبح جمعه :مثال ساده
 .TikTok ساخت ویدئو معرفی محصول برای :مثال فنی

 
 معنی کلمه 
Text  متن 

Image عکس 

Video ویدیو 

Audio صدا 
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 ابزارهای لازم برای تولید محتوا (6
 .کنند محتوا بسازیمهایی که کمک میوسایل و برنامه :تعریف

 موبایل  :ابزار ساده
 Canva ،CapCut  ،Kinemaster ,VN،Inshot افزارنرم :ابزار فنی

 .عکس گرفتن با موبایل :مثال ساده
 ، فتوشاب و ایلستراتورو افزودن متن Canva ویرایش عکس با :مثال فنی

 
 معنی کلمه 

Tool ابزار 

App  برنامه 

Edit  ویرایش 

 
 های فریلنسریپلتفرم ( 7

 :تعریف
 .دهندهایی که مردم به فریلنسر کار میوبسایت
 :المللیهای بینپلتفرم
• Fiverr 
• Upwork 
• Freelancer 

 که در آن تولید محتوا میشود:  های قابل استفاده برای افغانستانپلتفرم
 فیسبوک •
 اینستاگرام •
 اپ واتس •
 لینکدین •
 یوتیوب  •
 تیک تاک •

 :مثال ساده
 .سازممی من بگویی توانیمی تو  →خواهم” نویسد: “لوگو مییک نفر در فیسبوک می

 معنی  کلمه 
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 :مثال فنی
 .و گرفتن پروژه طراحی کارت ویزیت Fiverr نام درثبت
 
 
 ( Portfolio) پروفایل و نمونه کار  (8

 :تعریف
 .پروفایل یعنی صفحه معرفی خودت

 .ای، حتی اگر تمرینی باشدنمونه کار یعنی کارهایی که قبلاً ساخته
 :مثال ساده

 .داریهای خوبت را در یک آلبوم مشخص نگه میعکس
 :مثال فنی

 ید.گذار سازی و به عنوان نمونه کار در فیسبوک میچند پست تمرینی می Canva در
 معنی  کلمه

Profile  صفحه معرفی 

Portfolio  مجموعه نمونه کار 

Sample Work  نمونه کار 

 
 زمانبدی در انجام وظایف:  9)

 :تعریف
هایت  ریزی کنی که کارهای آنلاین باعث کم شدن کیفیت درسمدیریت زمان یعنی طوری برنامه

 .را به شکل منظم ختم کنی (Task) نشود و بتوانی چند وظیفه 
دریافت کنید. اگر   چندین سفارش همزمانهای خوب، گاهی ممکن است به دلیل داشتن مهارت

 .تواند به کار آنلاین شما آسیب بزندریزی نداشته باشید، این موضوع میبرنامه 
تا او بداند شما چه مقدار وقت دارید و بتوانید با آرامش و   از اول با مشتری صحبت کنیدبهتر است 

 .کیفیت بهتر کار را انجام دهید
 .ددهیکنی، بعد نیم ساعت کار آنلاین انجام میاول تکالیف مکتب را تمام می :مثال ساده
 «Deadline» کنی و برای هر کار استفاده می Google Calendar برای یادآوری وظایف از :مثال فنی
 .یدکنثبت می

 

Platform پلتفرم/وبسایت کاری 

Account  حساب کاربری 

Order  سفارش 
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 نکات مهم مدیریت زمان
 Google Calendar استفاده از . 1

 .های خالیبرای یادآوری وظایف، تاریخ تحویل پروژه، ساعت درس و زمان
 رعایت نکات امنیتی دیجیتال . 2

 .ایسازی تأیید دو مرحلهصورت منظم و فعالتغییر دادن پسوردها به 
 کردن منابع کاری آماده  . 3

 .داشتن اینترنت قابل اعتماد، شارژ برق کافی، و پاوربانک برای روزهای ضروری
 ارتباط شفاف با مشتری   . 4

اگر مشکلی پیش آمد )مثل قطع برق یا مریضی(، فوری مشتری را در جریان بگذارید تا اعتمادش از  
 .بین نرود

 
 جدول لغات 

 معنی کوتاه کلمه
Time Management  مدیریت وقت 

Task  وظیفه / کار مشخص 

Deadline  آخرین مهلت انجام کار 

Calendar  ریزی تقویم برنامه 

Communication  ارتباط مؤثر 

 
 فعالیت ها 

 ۱فعالیت 
یا   Upwork  ،Fiverrها مانند  تحقیق کنند. یکی از پلتفورم  های فریلنسریپلتفورم آموزان در مورد  دانش 

Freelancer   کند و چه نوع توضیح دهند که این پلتفورم چگونه کار می  یک پاراگرافرا انتخاب کرده و در
 .شودکارهایی در آن انجام می

 ۲فعالیت  
 .توانند از اینترنت درآمد داشته باشندشهروندان افغانستان چگونه میآموزان بررسی کنند که  دانش 

در مورد    ای کوتاهخلاصهرا تحقیق کرده و   Facebook و   YouTubeهای کسب درآمد از  آنها باید روش
 .آن بنویسند

 ۳فعالیت 
را بررسی کنند و بنویسند    ایجاد حساب کاربری و شروع کار در یک پلتفورم آنلاینآموزان مراحل  دانش 

 .ها شروع کندتواند کار خود را در این پلتفورمکه یک فرد چگونه می
 ۴فعالیت 
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را بنویسند؛ مانند آزادی در زمان کار، کار از خانه، رقابت زیاد، و   مزایا و معایب کار آنلاینآموزان دانش 
 .مشکلات دریافت پول

 ۵فعالیت 
اینترنت درآمد داشته باشند. هر دانشآموزان تصور کنند که میدانش  از  بنویسد که  خواهند  از  آموز 

مثل طراحی گرافیک، ترجمه، تولید ویدیو،  )  دهدکند و چه نوع کاری انجام میکدام پلتفورم استفاده می
 ( یا آموزش آنلاین

 
 
 

 سوالهای چالشی 
 فریلنسر کیست؟  :1 سوال
های مختلف را برای  کند و پروژهفریلنسر شخصی است که برای یک اداره ثابت کار نمی  :جواب

 .گیرددهد و در بدل آن پول میمشتریان انجام می
 تفاوت اصلی کار اداری و فریلنسری چیست؟: 2 سوال
تواند از کند؛ اما در فریلنسری فرد میدر کار اداری فرد در یک اداره با ساعت مشخص کار می :جواب

 .خانه یا هر جای دیگر با اینترنت کار کند
 .یک مثال ساده از فریلنسری بنویسید :3ل سوا

گیرد اما در یک دکان  نویسد و پول میمانند شاگرد خطاطی که برای هر نفر کارت عروسی می :جواب
 .کندثابت کار نمی

 سه مهارت مهم برای شروع فریلنسری چیست؟ :4 سوال
 .تایپ کردن، استفاده از کمپیوتر یا موبایل، و داشتن ارتباط مؤدبانه با مشتری   :جواب
 تولید محتوا چیست؟ :5 سوال
 .هاسایتهای اجتماعی یا وبتولید محتوا یعنی ساختن متن، عکس، ویدیو یا صدا برای شبکه  :جواب
 .چهار نوع تولید محتوا را نام ببرید :6 سوال
 .متن، عکس، ویدیو و صدا  :جواب
 .دو ابزار مهم برای تولید محتوا را نام ببرید :7 سوال
 CapCutو    Canva: جواب
 .دو پلتفرم معروف فریلنسری را نام ببرید :8 سوال
 Upworkو   Fiverr: جواب
 های فریلنسری به چه معناست؟ پروفایل در پلتفرم :9 سوال
 .کنیدهای خود را معرفی میای است که در آن اطلاعات و مهارتپروفایل صفحه  :جواب
 چرا مدیریت زمان در کار آنلاین مهم است؟: 10 سوال
توان چند کار را به موقع انجام داد و اعتماد مشتری را حفظ  زیرا با مدیریت درست زمان می  :جواب

 .کرد
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 درس هفتم 
 هوش مصنوعی 
 مفاهیم ابتدائی 

قبل از آنکه به مبحث هوش مصنوعی بپردازیم باید چند سوال را مطرح کنیم تا موضوعات آتی را بخوبی  
 درک نماییم:

تا به حال فکر کرده .1 انجام میآیا  از قبل برای آنها  اید که کمپیوترها تنها کارهایی را  دهند که 
 دستور داده شده است؟ 

 ها فکر کرده و تصمیم بگیرند؟ توانند تا حدی مانند انساندانستید که برخی کمپیوترها میآیا می .2
 ها صحبت کنند؟ها بتوانند مانند انساناید که در آینده دستگاهآیا تا به حال به این فکر کرده  .3
در  آیا می .4 را  کارمندان  برخی  نزدیک، هوش مصنوعی ممکن است جای  آینده  در  دانستید که 

 ادارات بگیرد؟ 
رود، ای نسبتاً نوظهور به شمار میهای علوم کمپیوتر است که گرچه پدیدههوش مصنوعی یکی از بخش

باشد. هوش مصنوعی در بسیاری از  های مختلف میاما به سرعت در حال رشد و گسترش در عرصه
ها  های علوم مدرن نقش مهمی دارد؛ از طبابت گرفته تا صنایع تولیدی و زراعت، که در این بخشحوزه

های چشمگیری داشته است. با این وجود، برخی باور دارند که استفادهٔ  کاربردهای گسترده و پیشرفت
تواند برای هوش و ذکاوت بشر یک چالش جدی ایجاد کند و میزان  بیش از حد از هوش مصنوعی می

نوعی، لازم  تحقیق و کنجکاوی انسان را کاهش دهد. بنابراین، پیش از پرداختن به موضوع هوش مص
 .است تعریف علمی و همچنین تعریف سادهٔ آن را بررسی کنیم

در این درس ما فقط معایب، مزایایی هوش مصنوعی  خواهیم پرداخت و صرف بخاطر آشنایی دانش  
 آموزان با مفاهیم و نحوه استفاده از آن میباشد. 

 تعریف علمی هوش مصنوعی:
شاخه مصنوعی  سیستمهوش  ساخت  و  طراحی  به  که  است  کمپیوتر  علوم  از  برنامهای  و  هایی  ها 

یادگیری،  می مانند  دارند؛  نیاز  انسانی  به هوش  انجام دهند که معمولاً  را  بتوانند وظایفی  پردازد که 
 .گیری استدلال، حل مسئله، درک زبان و تصمیم

 تعریف ساده:
 و   بگیرند  یاد  کنند،  فکر  انسان  مانند  بتوانند  که  هاییماشین  و  هابرنامه   ساختن  یعنی  مصنوعی  هوش
 .دهند انجام را کارها  بعضی

 چرا به آن هوش مصنوعی میگویند؟
 .سازی یا تقلید هوش انسان است گویند چون هدف آن، شبیهمی« هوش مصنوعی»به این فناوری 
 :به زبان ساده
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 .گیریهوش یعنی توانایی فکر کردن، یاد گرفتن، حل مسئله و تصمیم •
 .مصنوعی یعنی ساخته شده توسط انسان، نه طبیعی •

ای ساخته شده که بتواند کارهایی انجام گوییم هوش مصنوعی یعنی ماشینی یا برنامهپس وقتی می
دهد که معمولاً به هوش انسانی نیاز دارند، مثل یاد گرفتن، حرف زدن، تشخیص تصویر، حل مسئله 

 .گیریو تصمیم 
 « مصنوعی»تلفظ صحیح 

 .، حرف اول »ص« است و باید با صدای »ص« خوانده شودمصنوعیدر کلمهٔ  •
ها  کنند، حتی در رسانهبعضی افراد به اشتباه آن را شبیه »مثنوی« یا با صدای »ث« تلفظ می •

 .هم دیده شده است
 .آیداین اشتباه به دلیل عدم دقت در مخرج حروف و تقلید نادرست پیش می •
می • دقیق  وقتی  نوشتار  و  تلفظ  باید  کنیم،  استفاده  شده  تعریف  و  علمی  کلمات  از  خواهیم 

 .ها آمده است رعایت شودنامهها و لغتطور که در فرهنگهمان
 :آموزانپیام مهم برای دانش

طور که تعریف شده است تلفظ و نوشته شود تا اشتباهات رایج در گفتار و  هر کلمهٔ علمی باید همان
 .نوشتار کاهش یابد و فهم مطلب درست باشد

 :فرضیه
ها دستگاهی ساخته شود که با استفاده از فناوری هوش مصنوعی کارهای  فرض کنیم در دهات و قریه

 .زراعتی مانند قلبه کردن زمین را تنها با دستور دهقان انجام دهد و دیگر نیازی به تراکتور یا گاو نباشد
 :مزایا 

 .شودتر انجام میکارهای زراعتی مانند قلبه کردن زمین در زمان کوتاه :افزایش سرعت کار .1
 .دهقانان مجبور نیستند کارهای سنگین را خودشان انجام دهند :کاهش زحمت دهقانان  .2
 .تر قلبه کند تر و دقیقتواند زمین را منظمدستگاه می :افزایش دقت در کار .3
 .تواند در وقت کمتر کارهای بیشتری انجام دهددهقان می :جویی در زمانصرفه  .4
 .شوددیگر نیاز به گاو برای قلبه کردن زمین کمتر می :کاهش استفاده از حیوانات .5
موقع انجام شود، ممکن است حاصل وقتی کارها بهتر و به  :افزایش تولید محصولات زراعتی .6

 .زمین بیشتر شود
از  بخش مصنوعیهایی  کرده  هوش  پیدا  توسعه  بیشتر  امروزه  میکه  و  برای  اند  ساده  زبان  به  توان 
 :اند ازآموزان مکتب بیان کرد عبارتدانش 

 (Machine Learning) یادگیری ماشین . 1
دقیقا مانند   .سازندگیرند و عملکرد خود را بهتر مییاد مییتا در این بخش کمپیوترها از اطلاعات و د

یک انسان که متولد شده و زبان و همه کارها کم کم یادمیگرند ماشین نیز کم کم از دیتا یاد میگرند و 
 عملکرد آنها روبروز قویی میشود.
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بیند، این برنامه بعداً ویدیوهای مشابه را  ویدیوهای آموزشی می  YouTubeآموز در  وقتی دانش :مثال
 .کندبرای او پیشنهاد می

 (Natural Language Processing) پردازش زبان طبیعی . 2
 .توانند زبان انسان را بفهمند و با او گفتگو کننددر این بخش کمپیوترها می

 ,ChatGPT, Gemini, Cloud AI های هوش مصنوعی مانند باتتوانند از چتآموزان میدانش :مثال
Qwen, Grok, DeepSeek  سوال بپرسند و پاسخ دریافت کنند. 

 (Computer Vision) بینایی ماشین . 3
 .توانند تصاویر و ویدیوها را تشخیص دهنددر این بخش کمپیوترها می

گیرد، برنامه آن را  از یک شی یا متن عکس می  Google Lensآموز با استفاده از وقتی دانش :مثال
 .کنددهد یا ترجمه میتشخیص می

 (Robotics) رباتیک . 4
 .توانند کارهای مختلف را انجام دهندشوند که میها ساخته میدر این بخش ربات

 LEGO های آموزشی مانندهای آموزشی، شاگردان با استفاده از کیتدر بعضی مکاتب و کورس :مثال
Mindstorms  کنندریزی میسازند و برنامههای ساده میربات. 

 (Recommendation Systems) های پیشنهاددهندهسیستم . 5
 .دهندها بر اساس علاقهٔ کاربر، چیزهای جدید را پیشنهاد میاین سیستم

کند،  چند نوع ویدیو را بیشتر تماشا می TikTok, Instagram, Facebookآموز در  وقتی دانش :مثال
 .دهدبرنامه ویدیوهای مشابه را برای او نشان می

 (AI Content Creation) تولید محتوا با هوش مصنوعی . 6
 .تواند متن، تصویر یا ویدیو تولید کنددر این بخش هوش مصنوعی می

به کمک هوش    CapCutیا   Canva, Napkin AIتوانند با ابزارهایی مانند آموزان میدانش :مثال
 .مصنوعی تصویر، پریزنتیشن یا ویدیوهای آموزشی بسازند

 

 استفاده هوش مصنوعی در آموزش 
تواند  سازد، در برخی موارد میگونه که بسیاری از کارها را برای انسان آسان میهوش مصنوعی همان

هایی که استفادهٔ نادرست از هوش مصنوعی در آن  مضر و حتی خطرناک نیز باشد. یکی از بخش
آموزان بیش از حد به هوش مصنوعی  ممکن است مشکل ایجاد کند، بخش آموزش است. اگر دانش

وابسته شوند، ممکن است توانایی فکر کردن، تحقیق کردن و حل مسئله در آنان کاهش یابد.  
 .بنابراین لازم است از این فناوری در آموزش به شکل درست و متعادل استفاده شود
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 نکات برای ناظران دانش آموز 
 استفاده به عنوان ابزار کمکی  . 1

هوش مصنوعی باید به عنوان یک وسیلهٔ کمک آموزشی استفاده شود، نه جایگزین فکر و تلاش  
 .آموزدانش 

 تشویق به تفکر و تحقیق . 2
آموزان را تشویق کنند که ابتدا خودشان فکر و تحقیق کنند و بعد در صورت نیاز از معلمان باید دانش

 .هوش مصنوعی کمک بگیرند
 نظارت معلم . 3

استفاده از هوش مصنوعی باید تحت راهنمایی و نظارت معلم انجام شود تا شاگردان از آن به شکل 
 .درست استفاده کنند

 های اساسیتقویت مهارت . 4
 .هایی مانند خواندن، نوشتن، تحلیل و حل مسئله را خودشان تمرین کنندآموزان باید مهارتدانش 

 آموزش روش استفادهٔ درست از فناوری  . 5
آموزان باید آموزش داده شود که چگونه از هوش مصنوعی به شکل مسئولانه و مفید  به دانش 

 .استفاده کنند
 

 نکات استفاده هوش مصنوعی برای دانش آموز 

 هوش مصنوعی را فقط برای کمک استفاده کنید . 1
ها به شما کمک کند، اما نباید جای فکر کردن و تلاش خودتان را  تواند در درسهوش مصنوعی می

 .بگیرد

 اول خودتان فکر کنید . 2
قبل از اینکه از هوش مصنوعی سوال بپرسید، سعی کنید ابتدا خودتان جواب را پیدا کنید یا درباره آن  

 .فکر کنید 

 از معلم خود راهنمایی بگیرید. 3
کنید، بهتر است زیر نظر و راهنمایی معلم باشد تا  ها استفاده میاگر از هوش مصنوعی در درس

 .استفادهٔ درست آن را یاد بگیرید

 های خود را تمرین کنیدمهارت. 4
هایی هستند که باید خودتان تمرین کنید تا بهتر  خواندن، نوشتن، حل مسئله و تحقیق کردن مهارت

 .یاد بگیرید
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 از هوش مصنوعی به شکل مسئولانه استفاده کنید. 5
همیشه تلاش کنید از هوش مصنوعی برای یادگیری و پیشرفت استفاده کنید، نه برای گرفتن جواب 

 و یا هم برای تقلب و حل کردن سوال در جریان امتحانات!  آماده بدون یاد گرفتن مطلب

 . از هوش مصنوعی بعنوان دستیار استفاده کنید 6
برای ترجمه متنها، ترتیب و خلاصه گیری پیدا کردن منابع گم نام و نایاب ترتیب جملات و پاراگراف  

 های متون... موارد مشابه.
 
 .  بعنوان یک رهنما استفاده کنید7

فرض کنید شما معلم ندارید و زبان انگلیسی میخواهید یاد بگیرید بعنوان یک معلم از آن استفاده  
 کنید، درسهای فزیک و بیولوژی را از آن نوت برداری میکند. 

 نرم افزارهای هوش مصنوعی برای یادگیری 
شرکت های زیادی در بخش هوش مصنوعی فعالیت دارند و هر روز به پیشگامان این فناوری علاوه  

 میشود اما از جمله نرم افزارهای که ساخته شده است را در اینجا فهرست میکنیم:

ChatGPT1 . 
 ۲۰۲۲نوامبر    :تاریخ انتشار •
 OpenAI :  صاحب امتیاز •
 ایالات متحده   :کشور •
تولید متن طبیعی، پاسخ علمی و آموزشی، گفتگوهای طولانی و : در بخش هایبهترین  •

 منطقی 

2 .Google Gemini 
 ۲۰۲۳  :تاریخ انتشار •
 Google / Alphabet : صاحب امتیاز •
 ایالات متحده   :کشور •
 ها وجو و تحلیل اطلاعات اینترنتی، پاسخ سریع به پرسشجست  :در بخش هایبهترین  •

3 .DeepSeek 
 ۲۰۲۵ژانویه   :تاریخ انتشار •
 DeepSeek: صاحب امتیاز •
 چین   :کشور •
 های سریع و تولید محتوا در سطح جهانی، مخصوصاً در آسیاپاسخ :در بخش های  •

4 .Grok 
 ۲۰۲۳نوامبر  :تاریخ انتشار •
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 ایلان ماسک   xAI: صاحب امتیاز •
 ایالات متحده :کشور •
 های اجتماعی، پاسخ کوتاه و سریعتعامل و گفتگو در شبکه :بهترین در •

 5 .Qwen 
 نسخه عمومی( ) ۲۰۲۵نوامبر  :تاریخ انتشار •
 Alibaba Cloud  :صاحب امتیاز •
 چین :کشور •
 ها، کاربردهای تجاری و عملیاتی تولید محتوا، تحلیل داده  :بهترین در •

۶ .Claude 
 ۲۰۲۳ :تاریخ انتشار •
 Anthropic :صاحب امتیاز •
 ایالات متحده :کشور •
 های دقیق و ایمن، آموزش و مشاورهپاسخ :بهترین در •
 :آموزاننکته برای دانش   

عنوان کند و متعلق به یک شرکت و کشور مشخص است. بهبات در یک زمینه بهتر عمل میهر چت
 :مثال
 ChatGPT  :برای آموزش و تولید متن •
 Google Gemini :وجو و اطلاعات آنلاینبرای جست •
 Grok:  های اجتماعیبرای شبکه •
 : Qwen, DeepSeek برای تحلیل و تولید محتوا تجاری •

 

 
ترین هوش های مصنوعی است که جهان فعلاً در عرصه آموزش، تولید این چت بات از جمله محبوب 

 محتوا و برنامه و تحلیل دیتا استفاده میشود.
 

 سوال چالشی:
. روزانه بصورت میانگین چند ساعت در چی موارد از هوش مصنوعی استفاده میکنید و آیا استفاده  1

 میکنید یاخیر؟ 

DeepSeek Gemini Grok AI ChatGPT Claude AI Qwen AI 
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 . آیا تا هنوز برای تقلب از امتحان از هوش مصنوعی استفاده کرده اید؟2
. آیا میدانید که استفاده زیاد هوش مصنوعی ذهن را کند و ذکاوت را از بین میبرد؟ اگر میدانید چرا  3

 استفاده میکند؟
 

 


